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1.

2.

Safety precautions and measurement conditions

e Prior to mounting the profilometer onto the wheel, areas of contact of the side
supports with the wheel surface should be thoroughly cleaned from dirt.

¢ \When mounting the module on the wheel, do not allow heavy shocks of its support
against the wheel.

e The output window of the profilometer and profilometer supports must be carefully
inspected and cleaned.

¢ Do not use laser module in locations close to powerful light sources.

CE compliance

The profilometers have been developed for use in industry and meet the

requirements of the following Directives:

3.

e EU directive 2014/30/EU. Electromagnetic compatibility (EMC).
e EU directive 2011/65/EU, “RoHS* category 9.

Laser safety

The profilometer makes use of an c.w. 660 (or 405) nm wavelength semiconductor

laser. The maximum output power is 1 mW. The device belongs to the 2 laser safety class
according IEC/EN 60825-1:2014. The following warning label is placed on the profilometer

body:

LASER RADIATION
DO NOT STARE INTO BEAM
Output <ImW

Wavelength 660nm

CLASS 2 LASER PRODUCT
IEC/EN 60825-1:2014

The following safety measures should be taken while operating the profilometer:
¢ Do not target the laser beam to humans.

¢ Do not disassemble the sensor.

¢ Avoid staring into the laser beam.

General information

A laser profilometer IKP5 Series is designed for measuring of

e wheel flange height

e wheel flange thickness

e wheel flange slope

e rim thickness

e full profile scanning and analyze of wheel rolling surface

e maintaining of electronic wear data base

e control of tolerances and sorting in the course of checkup, examination, repair and
formation of railway wheel sets.

Measurements are made directly on rolling stock without wheel set roll-out.

Profilometers are implemented in three configurations: with the standard handle,

with the shorten handle (Short version) and very short handle (Super short version) . The
version with the shorten handle is intended to measure the wheels with the limited space for
installing the profilometer. The version with very short handle is specially designed to
measure wheels of Ansaldo Breda low floor trams with very limited space for
profilometer installing. This super short profilometer version has separate battery block,
connected by cable with laser module.

IKP-5 Series, Model 2017 Year [Revision 1.1.0] 10.11.2017
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5. Basic technical data

Name of parameter Value

Measurement range

Flange height, mm 20...45
Flange thickness, mm 20...50
Flange slope, mm 1...15

Rim thickness, mm 36...100 (30...90)
Diameter (calculation method), mm 400...1400

Measurement error

Flange height, mm +0.03
Flange thickness, mm +0.03
Flange slope, mm +0.1
Rim thickness, mm +0.1
Diameter, mm +0.1

Discreteness of indication

All parameters, mm 0.01

Profile measurement range, mm 145

Discreteness of the profile formation, not worse than, mm 0.025 (5800 points for profile)

Digital readout device (PDA) dimensions, mm see Fig. 3

Dimensions of laser scanning module, mm see Fig. 5

Measurement time, s adaptive, depending on surface quality,
4 average

Power supply (laser scanning module) 3.7V

Li-ion rechargeable battery
5400mAnh for standard IKP and
2400mAnh for Short and Super-short

The number of measurements that can be taken before battery 5000 for standard IKP and
recharge is not less than 2200 for Short and Super-short
Laser module battery life time 5 million measurement cycles
Power supply (PDA) 3.7V
Li-polymer battery

3300mAh
PDA memory capacity 100 000 measurements
Interface between laser scanning module and PDA Bluetooth
Working temperature range, °C -20...+50
Enclosure rating IP42 or IP64

IKP-5 Series, Model 2017 Year [Revision 1.1.0] 10.11.2017
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6. Example of designation when ordering
IKP-V-M-S-T-R

Symbol Description

\% Profilometer version:

without symbol - Standard version

Short - Short handle

SShort - Super short handle

SShort-EB - Super short handle and external battery

M Options of the set of magnets for mounting on the internal/external rim face:
S — standard. Standard magnets (specified by default).
F — forced. Reinforced magnets.

S Options of the support plates embodiment:

D — direct. Standard plates, profilometer is mounted on the internal rim face (specified
by default).

| — invert. Custom plates, profilometer is mounted on the external rim face.

Presence of the rim measurement rod.

Enclosure rating:
without symbol - IP42

64 - IP64
Example:
IKP-T - standard magnets; standard support plates; presence of the rim

measurement rod.
IKP-F-l — reinforced magnets; custom support plates.
IKP-Short-T - the shorten handle; presence of the rim measurement rod.

7. Complete set to be supplied

Designation Name Quantity | Weight,

kg

RF303M Digital readout device (PDA) 1 0.3

RF505 Laser scanning module 1 0.8

RF505.40 Charging device 5V 1.0A for PDA and laser module 2 0.2

RF505.42 Data cable 1

RF505.43 Bluetooth adapter 1

RF505.30 Packing case 1 1.2

IKP5_DB Database management system (CD) 1

RF505UM User's manual 1

Calibration tools (option):
RF505.11 Calibration block 4
RF505Calibr Calibration software

IKP-5 Series, Model 2017 Year [Revision 1.1.0] 10.11.2017
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The profilometer comes in the special case
that protects the device against any
possible damage during transportation.

8. Device structure

8.1. Basic components of the device and their functions

Fig. 1 shows basic components of the device:

Figure 1
(1) Digital readout device (personal digital assistant, PDA)
(2) Laser scanning module
(3) Calibration block
(4) Charging device
(5) Data cable

IKP-5 Series, Model 2017 Year [Revision 1.1.0] 10.11.2017
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8.1.1. Digital readout device

Digital readout device (PDA) is designed for control of the laser scanning module,
data reception from the scanning module, indication of measurement results, parameter
input, and data storage.

6 5

Figure 2
Fig. 2 indicates:
(1) Turn-on button
(2) Charging indication, red/blue LED
(3) Connector to PC USB-port or charging device
(4) Flash memory card connector
(5) Stylus
(6) Bluetooth antenna
Overall dimensions of PDA are shown in Figure 3:

Figure 3

IKP-5 Series, Model 2017 Year [Revision 1.1.0] 10.11.2017
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8.1.2. Laser scanning module

The module is intended for laser scanning of the wheel surface.

Figure 4
Fig. 4 indicates:
(1) Turn ON button
(2) Indicator of turn ON (red LED)
(3) Indicator of Bluetooth connection (blue LED)
(4) Charging device connector
(5) Support for mounting of the device on the wheel flange
(6) Magnetic support for mounting on the wheel side surface
(7) Charging indication, red/green LED
(8) Output window
(9) Rim measurement rod
o IKP-T
Overall dimensions of the standard scanning module are shown in Figure 5.

224
67 : 168

151

130 max

Figure 5

IKP-5 Series, Model 2017 Year [Revision 1.1.0] 10.11.2017
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e IKP-Short-T
Overall dimensions of the scanning module with a short handle are shown in Figure

Figure 6
¢ IKP-SShort

Overall dimensions of the scanning module with a very short handle (Super Short
version) are shown in Figure 6.1.

Figure 6.1
¢ IKP-SShort-EB

Overall dimensions of the scanning module with a very short handle and an external
battery are shown in Figure 6.2.
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Figure 6.2
8.1.3. Calibration block

Calibration block is intended for calibration and tests of the profilometer. Calibration
block is a metal imitator of the part of wheel with a definite profile.

Overall dimensions of calibration block are shown in Figure 1A of paragraph 30.3.
Also possible is supply of a unit with a profile made to the customer’s drawings.

9. Operation principle

Operator mounts the laser scanning module onto the wheel to be measured. Having
received a command from PDA or PC, the laser module performs non-contact scanning of
the wheel surface. Measurement results (geometric parameters and profile of the surface)
are displayed on PDA, can be saved in the PDA memory, and transferred to the PC
database. Simultaneously, additional parameters can be saved: operator number, side
identifier (left or right wheel), axis number, locomotive (carriage) number, wheel pair
number, etc.

Video demonstration: https://riftek.com/eng/products/~show/instruments/railway-
devices/railway-wheel-profile-gauge-ikp

10. Geometric parameters of the wheel under
control

Geometric parameters of the wheel are calculated automatically after laser
scanning of the wheel is completed. To calculate geometric parameters, use is made of
reference points on the wheel profile. Location of the reference points is defined by L- and
P-parameters. Values of L- and P-parameters preset in PDA are given in paragraph 14 .4.
and can be changed by the user.

10.1. Flange height, sH

Calculation of the flange height is determined by parameter L2.

The flange height is calculated as a distance measured vertically between the
flange top and the point of wheel rolling surface at any preselected distance (L2) away from
the inner face of the wheel tire.

IKP-5 Series, Model 2017 Year [Revision 1.1.0] 10.11.2017
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i

Calculation of the flange thickness is determined by parameter L3 that specifies
Point 1 on the flange surface. There are two ways to specify the parameter:

Method 1

10.2. Flange thickness, sD

Height L3 is measured vertically| —
upward from a point of the wheel
rolling surface, the position of which
is defined by parameter L2.

Method 2

Height L3 is measured ‘ertically
downward from the flange top.

POINT 1/

The flange thickness is calculated as a distance measured horizontally at any
preselected height (L3) between two points (Point 1 and Point 2) lying on the opposite
sides of the flange top.

There are two ways to calculate the flange thickness:

Method 1

Point 1 is defined by parameter L3. R
Point 2 is the intersection point of a \ \PDINT 1!
horizontal line and a line lying on the

internal face of the wheel. | ﬁ

Method 2

Point 1 is defined by parameter L3.
Point 2 is the intersection point of a| ,
horizontal line and the flange surface.

Note: Both calculation methods can be performed simultaneously.

IKP-5 Series, Model 2017 Year [Revision 1.1.0] 10.11.2017
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10.3. Flange slope, gR

Calculation of the flange slope is determined by parameters L1 and L3 (or L4).

Height L1 is measured vertically downward from the
flange top and determines Point 3 on the flange
surface.

Height L4 is measured vertically upward from a point
of the wheel rolling surface, the position of which is 3
defined by parameter L2 (wheel rolling circle), and
determines Point 4 on the flange surface.

Height L3 is described in paragraph 10.2.

POINT 3

There are three ways to calculate the flange slope:

Method 1 =]
Calculation in millimeters
The flange slope is calculated as a /PDINT Toor 4
distance measured horizontally !
between Point 3 and Point 1 (or 4). the |
The PDA screen displays information POINT 3 i
in millimeters. ﬁ
Method 2
POINT 3
Calculation in degrees ﬁ\
The slope is calculated as the /
inclination angle of a straight line
passing through Point 1 or 4.
The PDA screen displays information POINT 1 or 4 ﬁ
in degrees.
Method 3
Pass/Fail
The calculation is performed according
to Method 1.
The PDA screen displays information
only about whether the measured slope
meets the tolerance conditions or not.

10.4. Wear parameters

The following wear parameters are calculated automatically:

Vertical wear Wt [is calculated as the difference between the measured flange height and the
flange height of the selected reference.

Horizontal wear Wf |is calculated as the difference between the measured flange thickness and the
flange thickness of the selected reference at height L3.

Corner wear Wr |is calculated as the distance along the normal to the tangent at the point at
height L5 from the wheel rolling circle of the measured profile, and the selected
reference.

oW F \}(

L3
=

LS
-
n

)
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* Red color indicates the worn profile

Hollow HI is calculated as the difference between the maximum and minimum values
within the specified limits.

The search limits:

- parameters of the minimum value [P7_1..P7_2]

- parameters of the maximum value [P8_1..P8 2]

Mo
P7_2
PB_1
FS_2
Difference of dD [is calculated as the difference between diameter at point D1 and diameter at
diameters point D2.
=
<]
Dl
Ie
Even wear W1 [is the maximum vertical wheel wear selected from several measurements.
Uneven wear W2 |[is the difference between the maximum wheel wear and the minimum wheel
wear (selected from several measurements).

10.5. Angle parameters

The following profile parameters are calculated automatically:

Inclination A is calculated as the profile inclination angle (in degrees) at a point with coordinate
L8.
Angle 1 S1 is calculated as the inclination angle of the straight line (in percents) passing

through points on the wheel surface located at preset distance L6 from the wheel
face and the distance L6+10mm from the wheel face.

Angle 2 S2 |is calculated as the inclination angle of the straight line (in percents) passing
through points on the wheel surface located at preset distance L7 from the wheel
face and the distance L7+10mm from the wheel face.

L2

LG

L7

IKP-5 Series, Model 2017 Year [Revision 1.1.0] 10.11.2017
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10.6. Rim parameters

The following rim parameters are calculated automatically:

Rim width L is calculated as a distance measured horizontally between the internal
and the external basic wheel surface.

Metal flow sS |calculated as a distance measured horizontally between the external
basic wheel surface and external maximum wheel width

Rim thickness sT is calculated as a distance measured vertically between the internal rim
diameter and a point on the wheel rolling circle located on any preset
distance L2 away from the wheel face.

L11 is an external wheel diameter.

L11
sT

L2

10.7. Wheel diameter

Diameter D is calculated by the formula:

D = 2*T +L10,

T — rim thickness

L10 — diameter of the wheel center
Le

(=)
=
—

10.8. Parameters of tram wheels

The following parameters of the tram wheels profile are calculated automatically:

Flange thickness sD15 is calculated as a distance measured horizontally at the set
height (L15) between two points: 1st point is at the internal
flange surface, 2nd point is at the line lying on the internal
face of the wheel surface.

Flange thickness Df is calculated as a distance measured horizontally at the set
height (L3) from the surface of the wheel rolling circle
between two points lying on opposite sides from the flange
top.
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Rewerse slope f is calculated as a distance measured horizontally from the
point on the internal flange side at the set height (L3) to the
point on the line lying on the internal face of the wheel.

sD
sDlS

L1S
L3

|
|
L2 ‘

10.9. Wheel defects

The following parameters of defects of the wheel surface are calculated:

Slide sP is calculated as a difference of the wear measurements in
two places of the wheel: on the slide and close to it (in the
place without defects) at the point on the wheel rolling circle
at any preset distance (L2) from the wheel face.

Cavity size hR is calculated as a difference of the wear measurements in
two places of the wheel: on the cavity and close to it (in the
place without defects) at any profile point.

Cavity area sR is calculated in the place of the maximum deviation.

11. Coordinate system

When comparing the profiles, two variants of location of the coordinate system of
the wheel is possible to use.

Coordinate system origin

Top
When comparing and displaying profiles, the
coordinate system origin is located at the
intersection point of lines passing through the

profile top and the internal wheel surface. ﬁ

Wheel rolling circle !
When comparing and displaying profiles, the
coordinate system origin is located at the
intersection point of lines passing through the
wheel rolling circle.

X
L2 ﬁ
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12. First activation and measurement procedure

Charge accumulators of the laser module and indication device by connecting them
to charging devices (see par. 28).

12.1. Activation

e Turn the PDA on by pressing the button (1), Fig. 2. The PDA screen will show the
main program window containing: main menu; indicators of PDA and laser
module charging degree; indicator of Bluetooth connection.

Laser Wheel Profilometer. IKP-5 Series, Model 2017 Year

Measurement of the wheel parameters
Wersion 4.4.2

’ Profiles ‘ % i

RFEOE FOA

95 95
' \_: l Measuremen * Mo connection
| RFEQS 04415

RIFTEEK, Belarus, Minsk, telffax +375-17-261-35-13 e-mail: info@riftek com, hitp: /f wwew riftek, cam

Button Assighment
Device Setting the PDA basic parameters (p.13)
Parameters Setting the measurement parameters (p.14)
Settings Setting parameters of database, tolerances, and others (p.15)
Profiles View the wheelset profile (p.20.2.)
Measurement Run the measurement process (p.12.2.)

¢ Switch the laser module on by pressing and holding button 1 (Fig. 4) for several
seconds. When connecting the laser module, a red LED blinks (2).

o After the laser module is switched on, some time will pass until automatic
wireless communication is set between the profilometer and the PDA, which is
accompanied by blinking of a blue LED (3) on the laser module. The LED
goes out when the link is established.

e The main program window will be updated.

Measurement of the wheel parameters m

Wersion 4.4.2

’ Profiles ‘ : :] i

R.FE05 PCA
’l l Measuremen

4 %% 95 95
RIFTEEK, Belarus, Minsk, telffax +375-17-281-35-13 e-mail: info@riftek com, hitp: /f wwew riftek, cam

* Cannectad with
III RFEQS 04415

The Measurement button, indicator of Bluetooth connection, serial number of the
laser scanning module, and indicators of the charging degree will be active.
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12.2.

Measurement

There are two types of measurements:

1. Rapid measurements without saving the results.

2. Measurements by using the selected scheme with saving results to database.
The measurement procedure by using type 2 is described in par. 18. How to select

the measurement type see in par. 13.1.

Measurement by using the scheme (type 2) is used for full-featured work with the

profilometer with maintaining the database of measurements.

@)

Attention!

Before installing the scanning module onto the wheel, you need to remove the dirt from the areas,
where the laser scanning module will be in contact with the wheel surface.

When installing the laser scanning module onto the wheel, awid of strong impacts of its supports,
because it can lead to incorrect operation of the profilometer.

o

You need to inspect periodically the output window and basic supports of the laser scanning
module and to clean them of dirt.
Do not clean the glass by using abrasive and aggressive cleaning agents.

To perform the measurement, it is necessary to:

e Fix the laser module on the calibration unit or wheel by mounting the module
support (5) onto the wheel flange and pressing magnetic support (6) to the internal
face of the wheel.

e For the rim measurement, extract the rim measurement rod and hitch it up to the

rim.
Rim thickness
measurement rod
Figure 6
e Make sure that the module is mounted correctly without any misalignment and
gaps.

¢ Press the Measurement button on the PDA display.

¢ With the Measurement button pressed, the laser module will scan the wheel
surface. During scanning time of about 1-2 seconds a red LED (2) is lit.

e When scanning is competed, the PDA will show values of measured parameters
selected for presentation (see par.14.2.).
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Wheel parameters
(/) Reference iﬁ
sH : 29.91 30.00 mm
Sl sD : 31.98 31.92 mm
gR : 10.32 10.3Z2 mm
FEO A :67.66 65.31°

When the parameter goes beyond set limits its value is highlighted with red color:

Wheel parameters
Reference iJ :J
sH : IS 30.00 mm

£ sD : 25.18 31.92 mm

gR BN 10.32 mm

CES A :55.80 65.31°

The Reference option enables/disables the display of the reference profile
parameters on the screen (highlighted in green).
e To view the wheel profile click the Profile button, and the PDA display will show
the scanned wheel profile, the measured parameters, and parameters of
calibration unit (or a wheel, chosen as a reference):

Wheel parameters
DEEE =L
o 28 =19 a4 112 14
]
10 /—\ #
Measure 20 \
20 N
40 T
=]
[liu' Save E Y EIE

e If you scan the calibration block or the reference wheel and scanning results differ
from the reference values by nor more than 0.1 mm, the device is ready to work,
otherwise it must be calibrated in accordance with par. 27.1 or 30.

@ The Save button is not active in the Rapid measurements mode.
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13. PDA program setting

Prior to starting work with the profilometer, PDA program setting must be
performed.
The window of basic parameters setting is called by pressing the Device button in

the main program window (par. 12.1.):
Device

& Measure type

-I
l ® DatefTime 1 - Synchronization

< ; Device type

Button Assignment
Measure type Rapid measurements/measurements with saving results to database
Units of measurement Millimeters/inches
Date/time Date/time setting
Device type Device selection (IKP, IDK, IMR)
Language Language selection
Synchronization Synchronization with PC

13.1. Measurement type

Two measurement types are available:

1. Rapid measurements without saving the results.

2. Measurements by using the selected scheme with saving results to database.

To set the measure type, press the Measure type button. Then select the measure
type: Rapid measurement or Measurement by scheme. Press the Save button.

Setting type of measurement

(O Measurement by scheme

=

13.2. Units of measurement

All parameters as well as measurement results can be presented in the Metric
system (millimeters), or in the English system of units (inches). To set the units of
measurement, press the Units button. Next, select Millimeters (mm) or Inches (in), and
press Save.
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Units setting

O Inches (in)

=

13.3. Date/time setting

Press the Date/Time button and set the date and time by using the buttons |~ [,
Press the Save button.

DatefTime setting
20015 - 09 - 11 6 . 46 . 18

=

13.4. Device selection

The PDA Bluetooth-connection is automatically configured to work with the laser
scanning module supplied with the PDA. Moreover, the PDA provides operation with other
IKP scanning modules and measurement instruments for railway transport manufactured by
RIFTEK (Wheel Diameter Measuring Gauge, IDK; Back-to-Back Distance Measuring
Gauge, IMR).

To connect other devices, press the Device type button. The device selection
window contains 3 types of devices available for connecting to PDA: IKP, IDK, IMR.

Each type of devices has a list of available devices (with which the connection has
been established earlier, and which have been saved in the IKP memory).

Setting measurement device

Mvalable devices:

RF505 03512

If the needed device is in the list, you can select it and press the Select button. The
PDA will try to connect to the selected device.
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§§ Sensors & Instruments

appear:

device.

To add a new device, press the Add button. The Device searching window will

Device searching

Tap "Start" to search for other Bluetooth device,

Marne I Address I

0 Devices found

To search for

Device searching

Searching for Bluetooth devices. ..

Marne I Address I

0 Devices found

Device searching

Select a device to connect with and tap "Save"

Marne I Address I
RFS0S 00615 00:12:6f 2 feict

1 Devices found

[

screen:

Next, select the device and press the Save button to save the address of a new

Setting measurement device

Myvailable devices:

RF505 03512
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You can delete the device that you do not use anymore by pressing the Delete
button.

Setting measurement device

Are ol sure youl want to delete
e, this device?

13.5. Language setting

It is possible for the user to change the program language, form his own language
support files as well as change/edit the terminology used.

To select the language, press the Language button. Next, select the required
language support file and press the Select button.

Language setting

Prycciaa

l 7 select |

If no such file is available, it is necessary to use the new files preparation procedure,
which is described in par. 22.2.4.1., and then load a new language file from PC to PDA as it
is shownin par. 23.1.3.

13.6. Synchronization with PC

To transfer data between PDA and PC, it is necessary to synchronize them. There
are two ways of synchronization via USB cable.

When you select MS ActiveSync, synchronization with PC is performed via the
ActiveSync software (Windows XP), or via Windows Mobile Device Center (\Windows
7).

When you select Mass Storage, the device is detected in Windows as an external
storage device.

To select the type of synchronization, press the Synchronization button in the
Device window. Next, select the required type and press Save.
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Setting synchronization with PC

(O Mass Storage

L / Save ‘

To apply the changes, PDA will prompt you to restart. If you do not need to sync the
PDA with PC currently, you can restart the PDA later.

Setting synchronization with PC

Festart the device to apply the
O changes?
®

———
-
-
1]
(2]
M—

[» 7" Save \

14. Measurement parameters setting

The Parameters window, which is called from the main program window, is
intended for calculation settings of controlled parameters.

Parameters

@ Settings ‘

Button Assignment
Settings Calculation methods setting
Show param. Selection of displayed parameters
L Parameters L Parameters setting
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Calculation methods setting

To select the calculation method, press the Settings button. The following window
will appear:

NP Settings of measurement
arameter L2 from: radient: ar:
® Roling circle ® From L1 to L2 ® Height
O Flange O From Ll to L4 (O Equal. /Unequal.
radient in: enter coordinates:
@ Milimeters @ Flange top
O Both values (O Degrees O Raling circle

=

After selecting the required parameters, press the Save button to save changes.

Selection of displayed parameters

To enter the mode, press the Show param. button.

14.2.

Show parameters

MNarne I Show/Hide I =
Flange height{sH) vl
Flange thickness(z0) v
Flange gradient(gR.) V L]

Wheel dameter(D)

Rim thickness(T)

Wifear (W)
lonesiS)

=

To select/deselect the parameter to display, double-click in the Show/Hide column
opposite to the required parameter. After selecting, you need to press Save.

14.3.

L-parameters setting

To set L-parameters, press the L Parameters button.
In the table will be displayed only those parameters, which are necessary to

calculate the selected geometrical parameters of the wheel.

L-parameters

Code I Walue I I
L1 2.00 mm
L2 F0.00 mrm
L3 13.00 mrm
L15 15.00 mm

=

To edit the parameters, double-click in the Value column opposite to the required
parameter, and enter a new value in the Data Input window. Press the Enter button - ‘ﬂ‘
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Data Input @

Parameter value L1(mm)

[pod |-

1 2 3 4 5
6 7 8 9 0

| R

Caps
Lock

When you have set all parameters, press the Save button to save them.

14.4. Preset parameters values

Values of L-parameters preset in the PDA are given in the Table:

L- Default value Assignment
parameter
L1 2 mm Used for calculation of the flange slope (qR)
L2 70 mm Defines position of the wheel rolling circle, and used for calculation:
- flange height (sH)
- flange thickness (sD)
- flange slope (qR)
- inclination angle (A)
- wheel diameter (D)
- rim thickness (T)
- wear (Wt, Wf, Wr)
L3 13 mm Used for calculation:
- flange thickness (sD)
- flange slope (qR)
- wear (Wf¥)
L4 13 mm An additional point for calculation of the flange slope (qR)
LS 10 mm Used for calculation of an angular wear (Wr)
L6 70 mm Used for calculation of slope of the rolling surface section (S1)
L7 105 mm Used for calculation of slope of the rolling surface section (S2)
L8 10 mm Used for measurement of the profile inclination angle at the required
point (A)
L9 140 mm Used for inverting the measurement direction (L9 — profile width)
L10 599,35 mm Used for calculation of the profile diameter (D)
L11 767 mm Used for calculation of the reference profile rim thickness (T)
L12 140 mm Used for calculation of the wheel whidth(L) and metall flow (sS)
L15 13 mm Used for calculation of the flange thickness of tram wheels (sD15)
P7_1 50 mm Used for calculation of the hollow (HI)
P7_2 105 mm
P8_1 110 mm
P8_2 130 mm
D1 70 mm Used for calculation of the hollow (HI)
D2 107,5 mm
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15. Setting the database parameters, tolerances and

measurements schemes

The Settings window is intended to set the database parameters, tolerances,
measurements schemes, etc.
Settings

Button Assignment
Database Database selection
Reference Reference profile selection
Scheme Setting of measurement scheme
Tolerance Setting of tolerances
Wheel type Wheel type selection

15.1. Selection of the current database

You can save the measurement results to the PDA database when it is necessary.
The program makes it possible to create and store several database files related to the

date of measurement.
To select the database file, press the Database button.

Database

Current OB 15 09 04 0]

List of database files | |
wp_15_09_04_01.kp .

| g Select l

To create a new database, press the Add button. The window for entering a name

of a new database will appear.
By default, it will be prompted to form the database file with the name

wp_yy_mm_dd.ikp, where yy mm_dd is the current date:
yy - the lasttwo digits of the year;
mm — month;
dd —day.
You can agree with this name, or enter another:
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ol Data Input

Enter the name of the database

Iname ' *

Caps | |,
Lock ‘123‘

Press the Enter button - ‘ﬂ‘

Database
Current OB wp_15_12 03_01
List of database files I I
wp_15_12 03 _0Llikp .
narme.kp
. ;..t Add | | g Select l

To select a database from a list, activate the line and press Select. The selected
file will be marked with a "dot" symbol.

To delete the database file, activate the line and press Delete. If you delete the
current database, the error message will appear.

15.2. Reference profile selection and installation

The program allows to compare the scanned profile of the wheel with the reference
profile. To select the reference profile, press the Reference button.

Reference

Current reference

List of referencec | Mame of reference | | |~
BRU_Car_33.ref Car_33

BRU_Loco_33 ref Loco_33 .
Tram_Poland.ref Tram_Poland L]
GER_Trarm.ref Ger_Tram

Elnl Tram ref 4-DEATE i

o o
LS8 | = .

To select the reference file, activate the line and press Select. The selected file will
be marked with a "dot" symbol.

To delete the reference file, activate the line and press Delete. If you delete the
current reference, the error message will appear.
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15.2.1. Writing the reference profile to the database

Laser Wheel Profilometer. IKP-5 Series, Model 2017 Year

Reference profiles are stored in the PDA database as profile description files with
ref extension. The PDA is supplied with several pre-installed profiles.

If there is no required reference profile in the database, the user can request the
missing profile from RIFTEK (free service), and then transfer the received profile to the
PDA as shownin Par. 23.1.4.

15.3. Selection and formation of the measurement scheme

The measurement scheme is meant as a sequence of making
measurements/processing of wheels in the rolling stock with specified parameters of each
wheelset (wheelset numbers, car numbers, series, etc.). The program automatically offers
the operator to perform measurement of the wheel in accordance with selected scheme of
wheel processing. The program contains several preset schemes. Besides, the user can
form his own measurement scheme.

15.3.1. Selection or removal of the measurement scheme

To select the measurement scheme file, press the Scheme button.

Scheme

Current scheme IScheme2| Q
List of schemes | Marme of scherme | | |~
Pendolino sch Pendoling

Schemez sch Schemez2 .
Scheme3.sch Scheme3 =
Schermed sch Schermed

SchemeS sch SchemeS i

';'i Add I I;a's Delete l ';'i Select

To view the scheme, ﬁu need to activate the line containing the scheme file name
and to press the View button k.
Scheme

Schemez2 E

';.'i Add ';55 Delete | Select I

Arrows in the figure show direction of processing of wheel pairs as well as the
names assigned to wheels (1L-first axis, left side; 2L-second axis, left side; 1R-first axis,
right side, etc.).

To select the scheme file, activate the respective line and press Select. The
selected file will be marked with the symbol "-".

To delete the scheme file, activate the respective line and press Delete. If you
delete the current scheme, the error message will appear.
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15.3.2. Formation of a new measurement scheme

To form a new measurement scheme, press Add. The window for entering the

measurement scheme name will appear.
Type the scheme name by using the on-screen keyboard. Then press the Enter

button - .

New scheme
Marne of scherne INew scheme Q
The number of cars Il
Mumber of axles |4 =
Type of scheme | 1 =
==

Next:

¢ select the number of cars;

e select the number of axles;

e select the wheel processing scheme out of the options suggested;

e press Save.

You can look at the formed scheme by pressing the View button - .

This method of the measurement scheme formation allows to create only simple
schemes without specifying the wheelset numbers, car numbers, series, etc. To form a
complete scheme, see par. 29.

15.3.3. Loading of a new measurement scheme

If you can not create a new scheme as described in the previous paragraph, you
can use the special program for PC (see par. 29), and then upload that scheme to the PDA
as described in par. 23.1.5.

15.4. Setting of tolerances

The program automatically controls measured geometric parameters for going out
beyond the tolerances set. It is possible for the user to create groups of tolerances. Control
of parameters will be performed for a selected group.

To select the current group of tolerances, press the Tolerance button.

The table will show tolerances only for the selected geometric parameters of the
wheel.

The red color indicates the maximum/minimum critical values of parameters. The
orange color indicates the maximum/minimum values, which are close to critical values.

Tolerances setting

Far... |Min IWar...lWar... IlVIax I

sH-F... (20,00 22,00 31.00 33.00 mm
sD-Fl.. 12500 27.00 32.00 34.00 mm
gR-Fl...[5.00  7.00 10.00 12.00 rmm
Df-F... 125.00 29.00 30.00 32.00 mm

1] [
T O O
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To select the group of tolerances, activate the line and press Select. The selected
file will be marked with a "dot" symbol.

To delete the tolerance, activate the line and press Delete. If you delete the current
tolerance, the error message will appear.

To edit the tolerance, activate the line and press Edit.

To add a new tolerance, activate the line with the type name and press Add. You
will see on the screen:

New tolerance

= +)
MName of Tolerance INew tolerance

Parameter IMin IWar.Min I‘u“u’ar.... IMax I

sH-Flange height | 0.00 0.00 mm
sD-Flange thickn... 0.00 0.00 M
gR-Flangs gradient | 0.00 0.00 mm
Df-Hange thickn... 0.00 0.00 M

=

To change the type name, it is necessary to set cursor in the Name of Tolerance

field, and to enter a new value in the appeared window. Then press the Enter button - e
To edit the value, it is necessary to double-click on the Min/Max/War.Min/War.Max
column opposite to the specific parameter, and to enter a new value in the emerged
window. Then press the Enter button. If any parameter has a zero value, the tolerance will
not be used.
To save changes, press Save.

15.5. Wheel type selection and installation

If several wheels types are used, it is possible to set definite measurement scheme,
reference profile and L-parameters for every wheel type

For example, we have three types of wheels: WheelType1, WheelType2,
WheelType3. Every time for a new wheel type we can measure L-parameters, scheme,
reference and tolerances, or we can define these values for every wheel type, and select
only the required type.

Example
WheelType 1: Reference 1, Scheme 1, Tolerance 1, L-Parameters 1;
WheelType 2: Reference 2, Scheme 2, Tolerance 2, L-Parameters 2;
WheelType 3: Reference 3, Scheme 3, Tolerance 3, L-Parameters 3;

To select the wheel type, press the Wheel type button.

o-@-c Wheel type '_g]
Current whesl type  |car

(o
[ |

o Lo [

To select the wheel type, activate the respective line and press Apply. The selected
file will be marked with the symbol "-".

List of types of wheels
Tram
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To delete the wheel type, activate the respective line and press Delete. If you delete
the current type, the error message will appear.

To edit the wheel type, activate the respective line and press Edit.

To add a new wheel type, activate the line with the type name and press Add. View
on the screen:

New wheel type
Marmne |New wheel type [@ Settings \
Reference |Loco_33 ~] .
[g Show param. \
Scherne [scherne3 Ed|
Tolerance ITest talerance El [g L Parameters \
[» 7 Save \

To change the type name, it is necessary to set cursor in the Name field, and to

enter a new value in the appeared window. Then press the Enter button - \ﬂ|.
Next:
¢ select the reference profile (Reference);
¢ select the scheme (Scheme);
¢ select the tolerance (Tolerance);
¢ set Settings (Settings button, see par. 14.1.);
¢ set the displayed parameters (Show param. button, see par. 14.2.);
¢ set L-parameters (L Parameters button, see par. 14.3.);
e press Save.

16. Updating of PDA software

You can view the software version in the main program window:

Measurement of the wheel parameters m Soffware
Version 4.4.2 B 2
version

RIFTEK, Belarus, Minsk. telfax +375-17-281-35-13 e-mail: info@riftek .com, hitp: ff www riftek .com

The latest software version can be downloaded from the website:
www.riftek.com/media/documents/ikp/lkp5 PDA Software.zip
Procedure of PDA software updating is described in par. 23.1.6. of this manual.
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17. Shutdown
To shutdown the PDA, press the Shutdown button - E!

Wersion 4.4.2.1

Measurement of the wheel parameters m

Shut down the PDA?

TErTonnection
RFE0S 00415

RIFTEEK, Belarus, Minsk, telffax +375-17-281-35-13 e-mail: info@riftek com, hitp: /f wwew riftek, cam

18. Measurements with database maintenance

There are two types of measurements:

1. Rapid measurements without saving the results.

2. Measurements by using the selected scheme with saving results to the database.

Procedure of rapid measurements is described in par. 12. How to select the
measurement type, see par. 12.2.

The second type is used for a fully functional work with the profilometer with
maintenance of the measurements database.

When Bluetooth-connection is established, you can start to measure by pressing the
Measurement button in the main program window. The window of wheelset parameters will
appear on the screen:

Parameters wheelset

Date /02720 165 Operator |
N wheelset 5000111 Milezge I 1111

T

Series Rxle I 11
MNurmber 7102 Side I L : l

]

« " Save

Parameters fields will be filled in accordance with the selected measurement
scheme. If needed, you can fill/edit the required fields, and press the Save button to save
changes. The selected scheme will be displayed on the screen:

3-@{ Wheel parameters
Date 1 11/09/15 [ i[sH Q.00 mim
Series M3 a s Q.33 mm
Mumber 1 7102 gf. 0.00 mm
Qperator A 00 -
N wheelset :SU000111
Mileage p1111

1R 2R 3R dr

Designations and buttons:
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(é} an ordinal number of the car to be measured (number of cars in the rolling stock)

edit the wheelset parameters

pass to the previous/next wheel
pass to the previous/next car

4. |2 measured wheel
.- a wheel to be measured the next time

£—= |a non-measured wheel

&= |3 measured wheel to be measured again

measurement

Measure

18.1. Measurement

¢ Press the Measure button in order to measure the wheel offered by the program
(highlighted in green). The laser module will scan the wheel surface.

e Upon completion of the scanning process, the PDA will show the values of
selected geometrical parameters.

.||| Wheel parameters
Referenoe mj
sH : 29.92 30.00 mm

b sD : 31.95 31.92 mm
gR : 10.31 10.3Z2 mm

CE A :68.00 65.31°

When the value is beyond the tolerances, it will be highlighted in red:

it Wheel parameters =
i-BY P

Referenoe nﬁ
sH : IS 30.00 mm

£ sD : 25.18 31.92 mm

gR BN 10.32 mm
FEIA :55.80 65.31°

The program allows to display only parameters of the measured profile.To hide the
reference values, you need to untick the Reference box.
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Wheel parameters
(/] Reference iﬁ
sH : 29.92 mm
b sD 31.95 mm
gr : 10.31 mm

A © 6800 °

¢ To view the wheel profile, press the View button - @ The scanned wheel profile
and the selected reference profile will be displayed on the PDA screen.

Wheel parameters
HERE =0
i 28 =3 24 112 14clz|
10 /_\ #
Measure 0 \_
30 \_ -
40 T
0
[liu' Save EI A EIIE'

For more information, see par. 20.2.

¢ To repeat the measurement, press the Measure button.

¢ When a satisfactory result is obtained, press the Save button to save it.

e The program will offer to pass to the measurement of the next wheel in
accordance with the selected scheme of measurement.

Wheel parameters

Date 1 11/09/15 9i(sH Q.00 mmm

Series T CM3 g D .00 mm

Number 17102 gr. Q.00 mm

Operator : =

axle 12 A 000

M wheelset : SU000112

Mileage 1112 Measure

3R
I 1k 1

1R 2R
1
l l(ﬁ)
== < )
1L L N aL

e To view the results of previous measurements, you can use the arrows. If you
select the measured wheel, the saved wheel parameters will be displayed on the
PDA screen.
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Wheel parameters
: 11/09/15 f BlsH 2992 mm
eries i M3 a sD 3195 mm
umber : 7102 gR 10.31 mm
perator H °
xle :11 A 6800
wheelset :SU000111 A
ileage #1111 Measure

1R 2R 3R 4" !
® parameters
1L 3 AL i : 3L . &£ ¢

e When you measure the wheel that was already measured, the program prompts
you to replace the existing database file with the new one.

olo Wheel parameters
¥ 0, P

@

CEOA :67.47 65.31°

This wheelset already exists,
Save the new results? m m

18.2. Measurement of even/uneven wear

Measurement of an even/uneven wear is slightly different from a standard
measurement. To obtain the result of the wear, it is necessary to perform several
measurements at different points of the wheel. When passing to the measurement window,
an additional button Accept will appear on the screen.

olle Wheel parameters
& 0. §

Reference iﬁ

sH : 30.04 30.00 mm
CysD @ 31,91 31.92 mm
gR : 10.34 10.33 mm
wl : 0.04 mm
CEolw2 : 0.18 mm

After each performed measurement, you need to press Accept to save current
values of the wear. At subsequent measurements the program will automatically find the
maximum and minimum wear of the wheel and calculate an even/uneven wear.
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i Wheel parameters T
B4 il i

m Referenoe mj
sH : 30.04 30.00 mm

elisD @ 31,91 31.92 mm

gR : 10.34 10.33 mm
wl : 0.04 mm
o w2 0.18 mm

When a satisfactory result is obtained, press the Save button to save it.

18.3. Measurement of defects

IKP allows to measure defects of wheelsets.

e Slide size (sP)

e Cavity size (hR)

e Cavity area (sR)

Measurement of defects differs from the standard measurement.

The procedure of measuring the slide (cavity) is described below:

e Perform the measurement at the profile point that do not have any defects (slides,
cavities), which can be detected visually.

Wheel parameters

Reference m

sH : 29.88 30.00 mm
sD : 3191 31.92 mm
gk : 10.29 10.33 mm
sP : 0.00 mm
sR : 0.00 mm?2
hR : 0.00 mm

.:3-!;.2—::_1 * ;

—

'iu. Save 1

e If you obtained a satisfactory result, press the Apply button. The checkboxes
Slide and Cavity will appear on the screen.

Wheel parameters

Reference nﬁ

sH : 2988 30.00 mm
sD : 3191 3192 mm

il

D

i R : 1029 1033 mm
f:!d_e sP : 2.36 mm
sR : 0.00 mm?2

i Save hR : 0.00 mm

e Select the defect that you need to measure (tick the required checkbox).

¢ Place the profilometer properly (a laser beam must pass through the measured
defect).

¢ Press the Measure button to start the measurement.
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Upon completion of the measurement, the program calculates the value of selected
parameter.
When a satisfactory result is obtained, press Save to save data to database.

19. Measuring by IKP, IDK, IMR, and saving to
database

How to use the PDA with other devices is described in the corresponding User's
Manuals.

It is often needed that the measurement results obtained from different devices
were stored in one database. In this case, all entered parameters of the specific wheelset
must be the same in all devices.

These parameters are:

e Date

¢ N wheelset

e Series

e Number

e Axle

e Side (besides IMR)

Parameters wheelset |-§-|

Date W/02/2016 = Operator I
M wheelset SU000111 Mileage I 1111

Series (M3 Ade I 11
Mumber 7102 Side: IL :l

. Save

114

:

20. Browsing the database

To browse the saved data, press the Profiles button in the main window. The PDA
screen will display information about the current database, quantity of saved profiles, table
with saved profiles, and measured values of selected parameters.

Profiles |-§_|

Database 'wp_16_01_05_01
Mumber of profiles 7

Measured  /Reference
= sH | 20.87 23,00 | mm
L SUo001)sD | 3159 3192 mm
L SUA001j g | 10.33 10,33  mm
05/01/16 Q43 7102 14 L SUA001
05/01/16 Q413 7102 14 R SLUa031

33
38

Series

05/01/16
05/01/16 43 7102 13

05/01/18 a3 7102 13 SU0001
06/01/16 Q13 7102 12 SU0001

4 Coun

Buttons:

| | Browse the profile of selected wheel

Delete the selected wheel
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Add a filter

Delete a filter

Sawe the reference file

Data filtering

To add a filter, you need to press the Filter button, and to set filter parameters in the
appeared window.
An example of filtering by the Axle parameter:

ilter data
Date Series
[— 3 [ <]
Murmber Axde
E 3 e =]

The filtered field will be highlighted in yellow:

Profiles

Database

'wp_16_01_05_01

Mumber of profiles 2

Date

|Series |Number | Axde | F./L |N whiselg

Measured

FfReference

06/01/16 Oq3
06/01/16 43

7102
7102

12 L
12 R

SL00a1
SU00a1

H | 29.57
D | 3159
R | 10.33

30,00 | mm
3192 mm
10,32  mm

Ul

| i3S

To delete the current filter, you need to press .

20.2. Visualization of the wheel profile
To browse the wheel profile, you need to press the Profile button - . The

scanned wheel profile and the profile of selected reference will be displayed on the PDA
screen.

clle Profiles
8] o] °JEY 0

] 28 =3 4 112 1‘@ Measured  fReference
. /“\ " sH 2987 2000 mm

sD 3182 3192 mm

20 gf. | 10.33 10,23 mm
30 N

40 T

=]
H sl )
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Zoom in
Zoom out

Standard image scale
‘[h Browse the profile wear

An example of a zoomed image:

Profiles

alll Measured  fReference
sH 2887 3003 mm
sO 3189 3192 mm

\ gr. | 13,33 10,32 mm

\ b
m = : B
An example of visualizing the profile wear.

Information about the wear area is displayed on the screen. A positive wear area is
highlighted in green, a negative one - in blue.

Profiles
s
28 56

058, 84 1% 140 AI Measured  fReference
% sH 2988 30,00 mm

sD 31590 3192 mm
gr  10.34 10.33 mm

03s |

012

0.2
035

- — =

21. Installation of software on PC and startup

21.1. Installation of database support software

The ikp5_DB software is intended for maintaining wheel sets wear database on a
personal computer (the updated version of the program can be downloaded from
www.riftek.com/media/documents/ikp/lkkp5_PC_Software.zip).

To install the software, insert a compact disk to the PC CD drive, select and start
the Install_lkp5.exe file in the Software folder. Follow guidelines of the installation wizard.
By default, the software will be installed in the following directory C:\Program Files (x86)
\Riftek, LLC\Ikp5_db\.

21.2. Synchronization of PDA and PC

There are two ways of synchronization via USB cable to transfer data between PDA
and PC:

e MS ActiveSync
e Mass Storage
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When you select MS ActiveSync, synchronization with PC is performed via the
ActiveSync software (Windows XP), or via Windows Mobile Device Center (Windows
7), which must be installed on PC.

It is necessary to select MS ActiveSync as the synchronization type (see par.

- I L e———

File Settings | PDA Register Database Tools Window Help

| oo~

M Import Data === Mass Storage
:ﬁ.i Language file L4

ﬂ Reference file r

;_E] Scheme file »

E PDA update

When you select Mass Storage, the device will be detected in Windows as an
external storage device.

It is necessary to select Mass Storage as the synchronization type (see par. 13.6.).

To check if the MS ActiveSync synchronization is correct, switch on the PDA and
connect it to the USB port of the PC by the supplied cable. If the connection is successful, a
message about it will appear on the screen:

©) Windows Mobile Device Center BN
() Home -

Laser Wheel Profilometer. IKP-5 Series, Model 2017 Year

13.6.).

T

g Windows

s Mobile'

Set up your device

Get Outlook contacts, calendar, e-mail and other
information on your device.

. Connect without setting up your device

21.3. Program startup

To start the program, click Start > All programs > Riftek, LLC > IKP5_DB >
Ikp5_DB.exe. View of the main program window is shown below.

- Bl
’{ Measurement of the wheel profile parametel Elélg
Eile Settings PDA Register Database Tools Window Help

" = 5 ||
4 ¢ 8|5 Y o
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22. User settings of the program

22.1. Parameters setting

To go to the window of parameters setting, click Settings > Parameters in the
main window, or click @.

@ Parameters
JWheeIset's parameters | Calculated parameters | L-parameters | M eazurement method
M arne Show/Hide
Measurement date

M easurement time

Wheelzet

Series

Ale

Operatar

Fun O

Side

| @ Save | ‘ @ Cancel |

The window of parameters contains 4 tabs:
e Wheelset's parameters

¢ Calculated parameters

e L parameters

e Measurement method

221.1. "Wheelset's parameters™ tab

This tab is intended to select parameters, which will be displayed on the screen
when viewing the database.

JWheeIset's parameters | Calculated parameters | L-parameters | b eazurement method

[Mame Show/Hide

Measurement date
M easurement time
wheelzat
Series
Asle
Operator
Fun [l
Side

If the parameter is ticked, its value will be shown in the table of results and in the
table of profiles.
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22.1.2. "Calculated parameters" tab

This tab is intended to select the wheelset geometrical parameters, which will be
calculated and displayed on the screen when viewing the database.

‘wheelset's parameters | Calculated parameters | L-parameters | Measurement method

[Mame | ShowsHide |
Height [zH] v
Thickness [s0)

Thickness [:D1)
Farameter [sF]

Gradient [gR]

Driameter (L)

Tire [T)

Slope [51)

Angle [4)

Hallow HI)

Rirn width [L]

Wear [Wt)

Back-to-Back distance [M]
Multiple measurements (k)

RIRE AL RN RIE Y

Description and functions of parameters are the same as in the PDA software (see
par. 10.).

221.3. "L-parameters" tab

This tab is intended to set the values of reference points for calculated geometrical
parameters of the wheelset.

Wheelzet's parameters | Calculated parameters | L-parameters | Measurement method

Code |Value | |
Parameter L1 200 mm
Parameter L2 70,00 mm
Parameter L3 13,00 mm
Parameter L10 14975,00 T
Parameter L15 15,00 mm

Description and functions of the reference points are the same as in the PDA
software (see par. 10.).

22.1.4. "Measurement method" tab

This tab is intended to select the calculation method.

“wheelset's parameters | Calculated parameters | L-parameters | Measurement method

rParameter L3 from—————————  ~Thickness from:
+) Roling circle
Flangs Both walues
Gradient: W ear
+ From L1 to L3 +) Height
From L1 to L4 Equal. /Unequal
rGradient in: rCoordinates center:
1 Millimeters * Flange top
Deagrees o
Accept /Unaccept. Roling circle
rUnits measure——————————— lrwveed profle—————————————
+ mm + Mo
inch Yes

Description and functions of the measurement methods are the same as in the PDA
software (see par.10.).
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22.1.41. Selection of measurement units

All parameters and measurement results can be in the Metric system (millimeters),
or in the English system (inches).

To set the units of measurement, you need to select mm or inches in the Units of
measurement field. After saving the changes, all information will be displayed in the
selected units of measurement.

22.2. Database settings

22.2.1. Setting the path to database

It is possible for the user to change the drive and the directory of the profiles
database storage. In the main window, select File > Path to DB...

| Database Settings 23]

Path [C-\Pragram Files [«G6)\Fiitek, LLC\kpS_dbADE |[]

Next:

e click Ok

e specify a new path to the database

¢ confirm the creation of a new database

Ikp5_db... ‘ T

File not found:
£ I_‘h depouser.dbf;
locom.dbf;
series.dbf:
operator.dbf;
limmval.dbf:
wheelpair.dbf;
wheelstate.dbf:
wheelwear.dbf:
profile.dbf;
profilegost.dbf;

Create new database?

OTtmeHa |

All database files will be copied to the specified path.
TkpS_db... J- =)

I.-"'_"\-.I MNew path to the database:

"W CA\Program Files (x86)\Riftek, LLC\Ikp5_db\
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Creation of empty database

To create an empty database, select File > New DB.

i Measurement of the wheel profile parameters ‘
—

File Settings PDA  Register Database Tools Window Help

8 H IV

Device 4

i

= | DB import

| DB path...
off et

All data except the reference files will be deleted from the database. At the same
time, the DB(dd.mm.yy) directory will be created in the installation directory whereto all the
deleted data will be copied (dd.mm.yy — current date). If necessary, these data can be
restored (see par. 22.2.3).

22.2.3.

Import of database

To import data to the database from the other database, you need to:
¢ Select File > Import Data.
¢ Select the directory with DB files in the left window. All files will appear in the right

window:
=+ DB import EI@
Current path C:\Program Files [#86]%Riftek, LLCA\kpS_db\DE |
) PriceMinus a ||| 2| depouser
| PriceMMinnuz = Limwal
, PRicieMinauis = lacam
B Reference Assemblies Log
sy, 2o
il o o = | Prafile
y ﬁ;or;c:;}gest Application ] || Profie.DET
P o8 = ProfileGOST
) Languags || profilegost. DBT
\=| depouser (=] Series
.E. Filecopy = Syt
Ikp5_db =] user
Jirmeal =] wiheelPair
& WwheelState
mE‘ | wheel'ear
1] |
o8

¢ Click OK to import data.

22.2.4. Selection of software language

To change the software language, select Settings > Language and select the
required language support file.

File | Settings PDA Register Database Tools Window Help

%{O? Parameters w
" EMNG.Ing

ﬁ Language
RUS.Ing

3
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22.2.41. Preparation and installation of the language support file

The user can change the language, form his own language support files as well as
change/edit the terminology used. Language support files are located in the directory used
in the process of installation. By default, the following directory is used: C:\Program Files
(x86)\Riftek, LLC\Ikp5_db\Language\.

The directory contains two files, RUS.Ing and ENG.Ing, to support Russian and
English languages respectively.

To create the support file for any other language, itis necessary to:

e copy one of the existing files, for example - ENG.Ing, under the other name, for

example - DEU.Ing;

¢ edit the renamed file by using any text processor, namely, change all terms and

phrases to analogous ones from the required language;

e save the edited *.Ing file in the Language directory.

To change and edit terminology, it is necessary to:

e edit the corresponding language file by using any text processor;

e save the edited *.Ing file in the Language directory.

22.3. Registration data

22.3.1. Selection of the organization

To add/chose the user organization, select Registration > Organization.
Subsequently, this information will be used in automatic generation of reports.

#8 Organization registration EI@
|Cu:|de |Name |Fu|| harne |
3457 TCH t otive-power depat

[ Add ] [ & Delete ] [ ./ Edit

Buttons:

Add Add a new organization

i Delete Delete the selected organization

. Edt Edit the selected organization

@ Esit Exit the mode

To select a current organization:
e Click Edit

¢ Tick the depot

e Click Save
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Drganization
g Save
Code 3457 v =

Fuill narme Motive-power depot

22.3.2. Registration of operators

Steps to follow: Registration > Operator. Operators data are used for identifying
operators by Number.

] Operator registration EI@
| Murnber | M ame |

1 [vearory |

2 Petror P

Add ] [ & Delete ] [ ./ Edi

Functions of buttons are similar to those in par. 22.3.1.

22.3.3. Registration of series

Steps to follow: menu Registration > Series. Registered series of cars or
locomotives are displayed in the emerged window.

é] Series registration EI@
|Series narne Reference |

SERIEST LOCO_33

SERIESZ CaR_33

Add ] [ = Delete ] [ . Edit ]

When registering a new series, a new entry for this series will be added in the table
of tolerances automatically (see par. 22.3.5).

Functions of buttons are similar to those in par. 22.3.1.

When adding a new series, it is necessary to enter the name of the series and to
select the reference profile for it. Flange parameters of the selected profile will be
calculated and added to the table of tolerances automatically after saving the series (see
par. 22.3.6).
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22.3.4. Registration of car/locomotive numbers

Steps to follow: menu Registration > Number. Registered numbers of
cars/locomotives are displayed in the emerged window.

=| Car registration EI@
|Series |Number |
SERIEST 23467
SERIESZ 32664

TR

Functions of buttons are similar to those in par. 22.3.1.

22.3.5. Registration of tolerances

Steps to follow: menu Registration >Tolerance. Registered series of

cars/locomotives with boundary values of calculated geometric parameters of the wheelset
are displayed in the emerged window.

1% Limit values @
|Selies | |F'arameter |Nolm _.t'-\lert mir Alert max _:I
SERIEST Height :H 2367 2600 27.00 31.00 3200 iR
SERIESZ2 Thickness <D 243 23.00 26.00 3200 34.00 mm
Gradient qR 294 5.00 £.00 11.00 12.00 i
Diameter O 0,00 0,00 0.0 0,00 0,00 mm
Thickness :DF 19,61 25.00 27.00 3200 33.00 iR

Only parameters, which were selected in the list of parameters, are available for
editing (see par. 22.1.2.).

Maximum/minimum critical values of parameters are indicated with a red color. An
orange color indicates maximum/minimum values of parameters, which are close to critical.

The Norm value is calculated and added to the table automatically when
adding/editing the series of the selected reference (see par. 22.3.3).

22.3.6. Registration of reference profiles

The program comes with several preset profiles. In addition, the supplied disc with
software contains the base of reference profiles. Profiles are in the Reference Profiles
directory and divided into separate directories for each country.

In addition, the user can form a description of the required profile himself or request
it from RIFTEK (free service).

To browse available profiles, select Registration > Reference:
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&' Reference profile EIIEI
|Prc-fi|e code E
Profile_E_Em_21

Car_29

Car_33

51002

Profile_FPE D
JIC/ERRI

JIC/ORE

FGC

FSDR3_140

51002_h28_30

51002_h23 315 [*]

T T
0 20 40 60 a0 100 120 140

& Delete l l _Flmport ] [ ____,Export

The window of profiles displays the table with the list of reference profiles, saved to
database, and a graphical view of the selected profile.
Buttons:

i Delete Delete the reference profile

e Impart Import the reference profile from *.ref file

= Expot Export the reference profile to *.ref file

Exit the mode

22.3.6.1. Request and registration of the profile file

To get .ref file of reference profile send the drawing of profile to RIFTEK
(info@riftek.com). Register the received .ref file as follows:

e click Import

e in the window appeared indicate the way to the .ref-file

e click Open

The profile will be added to the base of reference profiles.
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23. Data exchange between PDA and PC

To exchange data between PC and PDA, you need to select the device: File >
Device > RF303M-PDA.

i Measurement of the wheel profile parameters _
e

File Settings PDA  Register Database Tools Window Help

oo [ Blionron A

= RF505 - Profilometer I

=
EM Mew DB

= | DBimport

Data exchange between PC and PDA is performed by means of direct cable
connection of PDA to PC USB-port (special RF505.42 cable is supplied).

There are two ways of synchronization via USB cable:

¢ ActiveSync

e Mass Storage

For more details see par. 21.2.

23.1. ActiveSync synchronization

When you select this type of synchronization, additional features of data exchange
with PDA will be available:

¢ Transfer of database files to PC

¢ Transfer of language files

¢ Transfer of reference profile files

¢ Transfer of processing scheme files
¢ PDA software update

23.1.1. Transfer of database file to PC

To transfer the database file from PDA to PC, it is necessary to:
¢ select PDA > Import Data

i Measurement of the wheel profile parameters -
R =
File Settings | PDA Register Database Tools Window Help

ﬁ | @ﬁ Synchronization  # \H' ‘ w
|

)

e .

- Language file »

ﬁ Reference file L4

‘;_EI Scheme file r

E PDA update

e mark the required files in the emerged window and click OK
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] Select files =

Check a8 files

[n [measurement date [Series  [carno [wheelset [ade no [side |

1 16.01.18 1 1 1 L
2 16.01.18 1 2 2 L
3 16.01.18 1 2 2 R

Delete data from PDA after import

o Ok X cancel

0 Double-click on the selected file in order to see information about saved data.

23.1.2. Transfer of language file from PC to PDA

To transfer the language file from PC to PDA, it is necessary to:
¢ select PDA > Language file > Export

i Measurement of the wheel profile parameters _

File Settings | PDA Register Database Tools Window Help

| EE ‘ @t} Synchronization ¥ | @

% Scheme file

E PDA update

e select the required file

Lock in: I J. Language j Lo & B

Mame Date modified Type
7] ENG 01.10.1511:40 File "LM

|®[RUS 01.101511:39 File "LN

File name: I'.Ing

Files of type: |LNG files (*Ing
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If transfer is successful, the screen will show:

Resource's file is transmitting successfully!
-

23.1.3. Transfer of language file from PDA to PC

To transfer the language file from PDA to PC, it is necessary to:
53 ¢ select PDA > Language file > Import

i Measurement of the wheel profile parameters—

Eile Settings | PDA Register Database Tools Window Help

| ﬁ ‘ {gﬁ Synchronization  * E ‘ ﬂ
&J Import Data

=
ﬁ] Reference file

;,3] Scheme file »

PDA update

¢ select the required file

Select fles
ENG.LMG
[ RUS.LNG
l /Dk l l x Cancel l

If transfer is successful, the selected files will be saved to the specified path.
23.1.4. Transfer of reference profile files from PC to PDA

To transfer the reference profile file from PC to PDA, itis necessary to:
¢ select PDA > Reference file > Export

= e
8 Measurement of the wheel profile parameter:-

Eile Settings | PDA Register Database JTools Window Help

I iﬁ | {:?:ﬁ Synchronization LH ‘ w
H Import Data

ﬁ Language file

ﬁ] Reference file
»

| r
) Scheme file

E PDA update
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¢ select the required .ref file
If transfer is successful, the screen will show:

Resource's file is transmitting successfully!

23.1.5. Transfer of processing scheme file from PC to PDA

To transfer the processing scheme file from PC to PDA, it is necessary to:
¢ select PDA > Scheme file > Export

i Measurement of the wheel profile parameter:-

File Settings | PDA Register Database Tools Window Help

I ﬁ ‘ {gﬁ Synchronization  * lﬁr | ﬂ
M Import Data

[E.! Language file 4

E PDA update

e select the required .sch file
If transfer is successful, the screen will show:

23.1.6. Updating of PDA software

The latest software version can be downloaded from the website:
www.riftek.com/media/documents/ikp/lkkp5 PDA_Software.zip.
To transfer the update file to PDA, it is necessary to:

¢ select PDA > PDA update

§ Vessrement o eI e

File 3Settings | PDA Register Database Tools Window Help
ﬁ ‘ {:l?:ﬁ Synchronization  F \ﬂr | ﬂ

@ Import Data

[w.! Language file 4

E#;l Reference file 4

;& Scheme file r

PDA update

e select file for transfer
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If transfer is successful, the window will appear:

- -"-I Update transfered!
P Reload PDA.

23.2. Mass Storage synchronization

When you select this type of synchronization, PDA is detected as an external
storage device. Therefore, the only Import Data item is active. Transfer of
language/scheme/reference files from PDA to PC and back can be performed by simple

copying.
§ Measurement of the wheel profile parameters

File Settings | PDA Register Database Tools Window Help

% | @ﬁ Synchronization  # l}r | w

To transfer database files from PDA to PC, itis necessary to:

¢ select PDA > Import Data
¢ specify the path to the database on PDA (by default, SDMMC\Autorun\DB)

1] Select a source folder: |
=y [*] 0 check ot fles

B 6\ v 17 08 14 01kp |
[ Autorun

[N [measurement date [Series  Jcar Mo [Wheelset [Axde Ho [ side
1 160118 1 1 1 L
2 160118 1 2 2 L
I 160118 1 2 2 R

Delete data from PDA after import

o Ok X cancel

e mark the required files in the emerged window and click OK

@ Double-click on the selected file in order to see information about saved data.
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24. Working with profilograms and wear
calculations

Laser Wheel Profilometer. IKP-5 Series, Model 2017 Year

241. Browsing the graph and profile coordinates

To browse the saved profiles of the rolling surface, select Database > Profiles, or
click the Profiles button- ™/ |

_ A, —~
& Measurement of the wheel profile parameters - Measured profiles) ™ om0 T S i [ ]
[ File Settings PDA Register Dstabase Took Window Help

A e e E Y @

e ]
uuuuu |Numhel |Sanes ‘Whaa\sel ‘Ax\e ‘S\de

|em date e

0312.2015135649  |162 SsR 1 1
0312201613673 |162 SSR_ |2 1
03122016[161934  [1623  [SSR |1 1
03122015170510  |162566 |SSA |1 1
OE02016 110008 |7102  [CM3  [SUD0OTT1 11

NEE

06.01.2016/11:00:03 7102 CM3  suoo0112 12
06.01.2016/11:00:03 7102 CM3  SU000113 13
OE.01.2016/11:00:03 (7102 CM3 50000114 14
OE01.2016/11:00:03 (7102 CM3 50000114 14
OR.01.2016/11:00:03 7102 CM3  SU000113 13
06.01.2016/11:00:03  |7102 CM3  |suoo0Ti2 12

EIBEEEEEEEE

0 5 10 15 20 25 30 35 40 45 S50 55 60 65 70 75 80 8 90 95 100 105 110 115 120 125 130 135 140
X

- Measured profile

Profils Image
Cormpar L Parar Vae | | [Code [Measure: d | ]
200 |mm | HeightiH] EE
Fie 0
Hifsference, General parameters 7000 |mm | Thickness (D) 31.89 o
Measured Profile parameters 1300 |mm | Thickness (:DF] 55 |mm
1500 |mm | Gradet (@R) 103
7 Cacuiste
M| m Pararnet ters

At the left side of the window you can see the Table of profiles tab, which contains
a list of saved profiles. The table displays only those identification parameters of the wheel,
which were selected in the parameters window (see par. 22.1.).

When selecting a profile, it is possible to browse a graphical image and geometric
parameters of the measured wheel. To browse the coordinates of the selected profile, you
need to click the Profile Values button. After that, an additional tab with the measured
coordinates will appear.

Buttons:

Show/hide the Wear graph

Show/hide the Profile Values tab

Show/hide the Profile alignment tab

Save the profile image to file (.bmp file)

Print the profile image

Change the background color of the graph

p<! Zoom in/out the profile graph
Calculate geometric parameters of the wheel

)| [0 D (]| (2] | [
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24.2. "Parameters" tab

Calculated geometric parameters of the profile as well as L-parameters values are
displayed on the Parameters tab, which is at the bottom of the window.

Compare L Parameter |Eode |Value | | |E0de |Measured | |
G | ] Parameter L1 2,00 mm Height [sH] 29,88 ]
Eneral parametsrs Parameter L2 70,00 mm Thickness [s0] .89 ]
Measured Frofile parameters Parameter L3 13,00 mm Thlcl.mess [sDF) 31.69 mm
P ter L15 15,00 mm Gradient [gR] 10,33 ]

=% Calculat
|2 alculate

Parameters

If needed it is possible to change settings of the calculated parameters or support
points (see par. 22.1).

24.2.1. Selecting a profile to compare

There are two ways to compare:
¢ with the reference profile,
¢ with the measured profile.

To compare the measured profile with the reference one, it is necessary to tick the
Reference box.

When comparing with the reference profile, select the required reference profile in
the drop-down list.

Compare
v| Reference Loco 23
tdeasured ég:uggsﬂ:

Car_33

FGC
FSDR3_140

To compare two measured profiles (for example, profiles of left and right wheels), it

is necessary to tick the Measured box. The Table of profiles tab will show an additional
table for selecting a profile to compare.

24.2.2. Selecting L-parameters values

When calculating the geometric parameters of wheelsets, the specified support
points are used (see par. 22.1.3). There are two variants of L-parameters:
e General parameters

¢ Profile parameters

When selecting General parameters, values of L-parameters will be taken from the
default parameters file (see par. 22.1.3).

When selecting Profile parameters, values of L-parameters will be taken from the

profile file, i.e. the values, which were set in PDA when measuring the wheelset (see par.
14.3.).

Values of L-parameters are displayed on the screen in the table of parameters.

||:DC|E |\-"a|ue | |
Pararneter L1 200 mm
Parameter L2 70,00 mm
Pararneter L3 13.00 mm

Parameter L15 15,00 mm
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If necessary, it is possible to edit any value and to recalculate values of geometric
parameters of the flange. To do it, click Calculate. Parameters of the measured profile and
selected reference will be recalculated.

24.2.3. Geometric parameters of the profile

The table of calculated geometric parameters displays only those parameters,
which were selected in the parameters window (see par. 22.1.2).
Code Meazured  |Reference

Height [zH] 23,00 i
Thickness [0 n.89 3232 i

Gradient [9F] | EEl i

Parameters, which are beyond the set tolerances, are highlighted in red/orange
(see par. 22.3.5).

24.3. Wear calculation

24.3.1. Fast wear calculation

To obtain fast calculation of the profile wear at a certain point relative to the
reference, put cursor bar to any of the profiles, and when a cross-like (+) mouse cursor
appears press the left mouse key. The resulting screen will show the value of the coordinate
difference between profiles taken along X- and Y-axes, as shown by arrows:

30 31 3z 33 34 35 36

To remove size indication from the screen, it is necessary to put cursor to any of the
profiles and press the right mouse key.
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24.3.2. Wear calculation at all points

To calculate the wear at all points of the measured profile, it is necessary to click the
Wear button. Calculated wear will be displayed on the screen in a graphic form:

0 5 10 15 20 25 30 35 40 45 50 55 60 65 70 VS 80 8 90 95 100 105 110 115 120 125 130 135 140
X

[= Measured profie - Refersnce piofile-Car_33 |

wearlmm 2] 2037133 227

sEannans SR T
0 5 1 5 121 130 135 140

Profile Image
The graph displays positive and negative values of the wear area. Value of the wear
area is calculated in square millimeters with respect to the selected reference profile:

Wearlmm™2] : 203133 227 MM

To view the table of wear values, it is necessary to select Profile Values > Wear.
The table will show deviations of the selected profile from the reference profile in two
directions (X and Y).

Al [valses IMta:n.red |Er[rrm I\\-w | -
| [ommes X Jonmds ¥ Jommas ¥ oo mas v |
s D 157 026
T |ues 10,90 10,55 0,06
3 |an 10,31 10,40 0,09
| 8,74 s 013
[F | 9322 536 013
6 |as 851 230 0,10
7 40 845 0,06
B e 7,95 #401 0,06
b | 7,50 7.5 0,10
10 |aes 7,10 732 013
11 4,11 62 L - 0,13
1z |438 5,37 &30 0,13
13 |oe 6,06 618 0,00
14 4,85 575 5802 0,07
5| 501 541 3.5 0,09
16 |50 5,08 50 012
7 |ss 4,80 149 0,09
18 5,86 4,56 462 0,06
1 |san 4,29 41 0,04
0 |e3s 4,01 4,06 0,05
P 3,74 3,81 0,07
22 |686 347 3,5 0,09
[ [ 3 12 1,08
1 |nas 30 308 0,06
35 |7eL 2,81 2,85 0,04

2 [280 851 26 |78 2,60 243 0,03 =

Frofile Image me.hvnn-.—l
24.3.3. Export to Excel, DXF, REF

To export the table to the Excel or DXF format or to create the reference file (REF),
it is necessary to right-click on the table. The pop-up menu will appear:

Export to Excel
Export to DXF
Export to REF

Select the needed menu item.
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24.4. Alignment of profiles

For alignment (vertical translation) of profiles, you need to click the Alignment
button. The program will display an additional tab, where you can select a profile:
Reference or Measured. The selected profile will be marked with red.

Alignment——— Alignment
Feference Step « 025 »
kMeasured Measured Win d 404
hee o 44 mm
o 0] o j Calculate
dv’ 9 mm =

Parameters | Alignment Parameters | Alignment

After selecting the profile, the screen will display the maximum and minimum
deviations of the selected profile from the reference profile [Min dY..Max dY].

Next, specify the translation step and move the profile by using the Up/Down,
Left/Right buttons.

L at

02 4 6 & 10 12 14 16 18 20 22 24 26 23 30 32 34 36 36 40 42 44 46 45 50 52 54 56 56 60 62 64 ©6 68 70 72 74 76 75 50 82 34 86 56 00 92 94 06 98 100102104 106 103110 112 114116 118 120 122124 126 128130 132 134 136 138 140
X

To save the changed profile, go to the tab of identification parameters of the profile
and click Save.

Table of profiles Iml

Wheel pararnetars
Organization sidfsfik dsfkdsifhdskr sdfl
Measurement date  |[0R.01.16 -
Series CH3 -
Mumber 7102 -
Wheelset Su0oat 11
Axle il
Side L -
Operator -
Mileage 1M

To create a new profile, it is necessary to change the identification parameters of
the profile.
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24.5. Superposition of profiles

To superimpose several changed profiles, you need to tick the required profiles in
the left table. Selected profiles will be displayed in different colors.

B=e RAA ="

z
o reom e 1

oo e 2 RN
T | / \
06.01.2016 11:0003 7102 SU000113 L v 5 /yAw

N

| 1

<

72 suoona R
003 702 susaniz R

RO % 38 % W G £ = 570 7% W% % 56753 100102108 106 10810 112 112115 115 120 122 124 126 128120 132 134 138 138 140

x
e ote eference profle FSDR3_140 — Prfie N7 Fiofle 13 = PrafleNi0 = Profle T Pl NG “Fioe N3 Pt

L Parameters 3 = [Esee Wesoued Jrefoenee | ]

Parameter ] nn | ReighGH) 12587 2550 o
TNET] m

04

24.6. Rescaling

To change the image scale, mark a part of the image with the left mouse key, move
the image by holding it with the right mouse key pressed, or with buttons Increase -
, Decrease - and Show all - .

1] 5 0 15 20 25 30 35 40 45 50 55 GO GBS TC

25. Implementation of minimum wheel truing
function

Select Tools > Analysis of profiles. The analysis of wheel profiles allows to
choose such a type of the profile from the reference profiles, for which the total truing depth
of two wheels would be minimal.

In the first table of profiles, select the first required profile of the wheelset (left
wheel); in the second table of profiles, select the second required profile of the wheelset
(right wheel).

The program allows to perform the automatic analysis by all the reference profiles,
which stored in the database, or by the selected profile only.

e Automatic analysis
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Tick the box and click the Analysis button. Profiles in the table of references must

not be marked.

[ = Analysis ]

e Analysis by the selected profile
Select the reference profile for analysis and click the Analysis button.

Lad File Settings PDA Register Databese Tools Window Help

l = Analysiz l
Reference -
51002

[

LIC/ERRI

[-]=]=

4o 85 VY @

Reference B
51002 O
b 7 Profile_P§ v
{ | 38 [ i LIC/ERRI O
4 | 3% 1]l i UIC/ORE ]
i 2 \ e q
i @ § FSDR3 140 O
18 51002_h28_30 ]
z / 2 Z \ 51002_h2e_31.5 O
= = 51002_hag_32.5 ]
2 0478 2 2 0378 51002 h28 e285 | [
B ] — 51002_h28_e28 O
P e AR T L 51002_h28_e295 0
L L = o 51002_h28_s23 m]
ot b e et 51002_h28_e305 ]
51002_h28_e30 ]
S1002_h20 e315 | [
51002_hag_e3l ]
2 ¢ S1002_h28 e325 | [
51002_h28_e32 [+
140135130125120115110105100 95 90 85 80 75 ;F(ﬂ 65 60 55 50 45 40 35 30 25 20 15 10 5 0 0 S5 10 15 20 25 30 35 40 45 S0 55 60 65 7}? 75 80 85 90 95 100105110 115120 125130 135 140 ‘H ¥y
Measurem |Measuieme [Number [Series |Wheeket  |asle |Side |Operator [ [[Code Measured Measurem |Measureme [Number |Seies |whesket  |Asle |Side |Dperator [][Code Measured
ik _Jjadine Heghl H) | 27,87 mm__||ontdate nt e Height (o) |27.67 m
13122015 135643 162 SSR 1 10 AR Thikress 5] 28 51 o ||03122075 135649162 SsR 1 [N Thickness (sD) |25 51 =
03122015 135733 |162 S5R 2 1n [Re Bradent () |852 || DE122015/1357.33 | 162 SR 2 10 RR Sradient [aR) |B52 P
03122015 16:1834 1623 |S5R 1 1L e 03122005 16153 1623 |S5R 1 1L mR
13122015 17.0510 | 162555 |S5R |1 1L e L 03122015 170510 | 162555 |S5R |1 1L R L
(6002016 110003 7102 |CM3  sUoooit |11 |L 06012006 110003 7102 |CM3  SUDOOTHT 11 L
06012016 11:0003 7102 |CM3 sUooonz 12 |L 06012006 110003 7102 |CM3  SUD0OTI2 12 L
6012016 110003 7102 |CM3 sUoooM3 13 L = 06012006 110003 7102 |CM3  SUOCOTI3 13 L =
4] I[+] 4] ]

To know the wheel cutting depth in a certain point, put the cursor to any profile, and
when a cross-like (+) mouse cursor appears press the left mouse key. The resulting screen
will show the value of difference between profiles along X- and Y-axes, as shown by arrows.
To remove size indication from the screen, put cursor to any of the profiles and press the

right mouse key.
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26.

26.1.

Scanning and filtering of data

Scanning and editing of data

Select Database > Table in the menu or click the Table button - = . The form with

results will be as follows:

17:06:10 02122015 |1 162555
06.01.2016 |5U000111 2
06.01.2016 |5U000112 7102
11:00:03 06.01.2016 |5U000113 7102
11:00:03 06.01.2016 | 51000114 7102

= ™
£| File Settings PDA Register Database Tools Window Help == =
=y — ==
4 8 &8 B Y| @
Organization Car
Mame Series CH3
Operator
MNumber 7102
Mumber
Name Measurementdate  06.01.16
Drag a columin headsr hers to group by that colurn
Heasuement| Measwre  [Wwheelset Humber Series Ale Operatar Mileage  |Height (sH] [Height (sH] [Thickness | Thickness |Gradient |Gradient |Diameter (D) Diameter (D)
tirne: [Left] [Right] (D] [Left] |(sD] Right] |[aR][Leftl |[qR] [Right] [(Left) [Right]
date
13:56:49 03.122M% 1 162 S5R 1 RR 278 2787 285 852
1357:33 03122015 |2 162 55R 1 RR 278 1876 24,45 4,55
16:15%:34 03.1220M% 1 1623 1 29,75

eS|

e Hide/show the field
The table displays the identification and geometric parameters of the wheelset,
which are selected for displaying in the parameters settings (see par. 22.1.1 and

22.1.2).

e Sorting of data
To sort data for any of the fields, click the left mouse key on the header of the field

column:

M eazureme
nt date

M eazurement
tirne

Wheelzeat

03122015
03.12.205
0312.205
03.12.2015

13:56:49
135733
161934
17:.05:10

— | =g =

=

Meazureme |Meazurement |'Wheelzet
i

=

] 1
03122015 16:13:34 1
0312205 17:.0510 1
03122015 135733 2

To cancel data sorting, press the Ctrl key and click the left mouse key on the
header of the field column.

e Filtering of data

In order to filter data in any of the fields, click the left mouse key on the header of the
field grouping, and select the required value in the emerged drop-down list:

0E.01.2016 | 11:00:03
OE.01.2016 | 11:00:03
06.01.20016 | 11:00:03
0E.01.2016 | 11:00:03

1
2
1
1

SUa00111
SU000112
SU000113
SU000114

Meazureme |k eazurement ' heelzet

06012016 | 11:00:03 SUn0o12
06.01.2016 |11:00:03 S0 13
06.01.2016 | 11:00:03 SUn00114

To cancel filtering, all steps should be taken in the reverse order.
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e Data grouping
To group data for any of the fields, click the left mouse key on the header of the field
column, and, with the mouse key pressed, drag it onto the table header:

Dy dEasung o header here to group by that |Mea$urement date |

Meazurement |'Wheelzeat

06.07.2016 |11:00 50000111
06.01.2016 | 11:00:03 sUo00i12 Meazurement date : 06.07.2016
06.01.2016 |11:00:03 SUooo113
0E.01.2016 |11:00:03 SUOo0114 +] Measurement date : 03122015

e Changing of the field position order

To change the field position, click the left mouse key on the header of the field
column and, with the mouse key pressed, drag it to the required position:
¢

" Tiheleet b eazurement| Measure Wheelzet
£ | [ tirme rneht
et - date
03122015 135643 o 155643 03122005 1
03122015 161934 |1 161934 |0312.205 |1
03122015 [17.0510 |1 170510 |0312.205 |1
Buttons:
Add Add the wheel pair
Delete the selected wheel pair
Delete all wheel pairs
Edit the selected wheel pair
Export the coordinates of wheel pairs to the Excel format
Report preparation
26.2. Editing data
You can edit, add and remove data in/from the database.
o Editing data
Edit wheelset - - =]
Parameters of wheelsets |Parameters |L‘Eft Right ‘ |
Height [sH] 2987 0,00 i
Measurement date Thickness [sD) .89 0.a0 mm
06.01.16 - Gradient [gR) 10,33 0.00 mm
Diameter (0] 0,00 0,00 mm
Wheelset
suooot 11
MHumber
oz -
Series
Ch3 -
Aule
1
Operator
Mileage
nn
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To edit the current entry, click the Edit button and input/change required values of

o Adding data

parameters. After the editing is complete, click the Save button.

Add wheelset

Parameters of wheelsets

Measuremen b date:
060116 hd

‘wheelset

|Parameters

[Leit

Fiight

Height [zH]
Thickness [sD)
Gradient [gR]
Diameter (0]

0,00
0,00
0,00
0,00

0,00
0,00
0,00
0,00

T
mm
T

T

Murnber

Operator

Wileage

l Save

[ @ Cancel

To add a new data entry, click the Add button and type required parameter values.
After the editing is complete, click the Save button.
e Deleting data

To delete the current entry, click the Delete button and confirm the deletion.
S

~
Tkp5_db...

l " Delete this Wheelset?

OTmeHa |

. —

e Deleting all selected data

If it is necessary to delete not only one entry but several entries combined by some
condition, filter the data according to the corresponding attribute (see par. 26.1.), click the
Delete all button and confirm the deletion.

("eps_db.. [5=)

l L Delete all Wheelsets?

OTmena

h —

26.3. Report preparation

When staying in the mode of scanning and editing data, the user can prepare
reports in Excel, RTF, PDF formats, or print out reports. When preparing the report, the
sorting used at the moment is taken into account.

To generate a report, press the Report button. The program will offer to select the
following options:
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Report

#) Report in Excel

1 Report to the printsr

26.3.1. Excel-format report

To prepare a report in Excel format, select Report in Excel and click OK.

(B 9 - o - [— _ B — Reportl ~ Microsoft Excal Y — — | O it
N oo | scome  Pouenocpawus oo Awee  Peuewwposawe S c@o@ B
P % oupess Mssmsar <8 - AN o | B ooun R B [t | weimpansieii [aneson F= 5 [ e A7 @
o il o & @. 2| voomee  copumporer. | ERETE = || gemmrs s oopur | W3 nom i
™ f vopuar o oepasy | K K W[ L 2 A [E & | B ovsemmrn woowecors suere - | - % w0 | 8 23, Loomes, omeroroer | EGRRNANN (SRR (coon 3| PRI OB 3 ownenme = L gunenp suaenima-
Ey02p obmera s wongr 5 Bupsermsare 5| twao | Crum | facin pegscrposarie
| RICL - F | Aarasamepa v
1 2 3 z 5 6 7 8 9 10 1 7 ] 1 0 16 7 18 19 0 2 2 3 2 % % 7 o
s [oeen  Konnapa Hawep Conn Oce  [Bocora  (Bocora Tomuwe Tomuwa |Kpgwowe Kpgesa [Mpokar Mpoxar &
S il LT T B ) I R )
1 (Neeoe) _(paeoe) _(flesce] _|(pasce] |(feeoe) _pasce) _(esce]
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26.3.2. Report for printout
To prepare the report for printout, select Report for printout and click OK. Data
will be presented in the form of report ready for printout.

|iPreview Q@
SEHLH BEEB w.- B 3B @& [EEE| 1«

Railway Railway N1
Department Dep artment N1
Name Name

Report of values of geomeiric parameters of wheel sets

Flange parameters Tyre parameter
Thickness Height Gradient Dinmeter Thickness

Identification parameters

Date | Wp.num |Axle Left | Right | Left | Right | Left | Right Right |Diff. | Left | Right

200912 000000000001 31,92 0,02 1029 0,00
200912 000000000002 390 | 3z | 000 [ o | 1020 [ 1028 0,00 0,00 0,00
200912 000000000003 3191 | 3194 | 3001 | 00 | 1033 | 1033 0,00 0,00 0,00
2009.12 000000000001 31,94 0,02 10,35 0,00
200912 |000000000002 3191 | 3138 | 3002 | 002 | 1032 | 1030 0,00 0,00 0,00
200912 000000000001 31,92 20,95 10,20 0,00
200912 000000000002 393 | 3193 [ 205 | w0 | 1020 [ 1020 0,00
200912 000000000003 3196 | 3194 | 2995 | 2095 | 1024 | 1024 0,00
200912 000000000004 392 | 3193 | w06 | w06 | 00z | 1022 0,00
200912 000000000001 31,94 0,92 10,19 0,00
200912 000000000002 3194 | 3195 [ w93 [ w03 | 1w [ 1009 I 0,00
2009.12 000000000001 31,92 0,01 10,37 0,00
200912 000000000002 31,89 0,01 1034 0,00
2009.12 000000000003 31,91 0,01 10,35 0,00

|IPags 1 of 1 A
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The top toolbar contains the following buttons for operating with reports:
e To printout the report, click =3
e To save in PDF format, click % .

« To save in Excel, RTF or PDF, click  and select the format you need:
hAi BEEB o

Text file...
RTF file...
Excel table (OLE)...
PDF file...

27. Taking measurements under PC control (without
PDA)

The laser scanning module (RF505) can work under direct control of PC without
PDA. To work under direct control of PC, it is necessary to select File > Device > RF505-
Profilometer in the main menu.

i Measurement of the wheel profile paramE'I:er_

File Settings PDA Register Database Tools Window Help

Doy
E: | Mew DB 1 RF505 - Profilometer

= | DBimport

In the main menu of the program, the PDA tab will be replaced with the
Profilometer tab.

i Measurement of the wheel profile parame‘be_

File Settings Register | Profilometer Database Tools Window Help

ﬁ '59} Z12W Calibration Q.J “

r{' Measurement

The menu contains two available items:
e Calibration

e Measurement
Before you start working with the profilometer, it is necessary to set the COM-port

for Bluetooth-connection between the laser scanning module and PDA. The procedure is
described in the User's manual that comes with the Bluetooth-adapter.
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27.1. Calibration

To calibrate the device, select Profilometer > Calibration, or click a1
[ Messurement of e whee prfie parameters_(Cairior) W W8 0 W RREE TRORT RSSO T e (o E )

| Eile  Settings Register Profilometer Database Tools Window Help [-[=]x
L AR-IE - A==
B (5] o [+ s |

‘ COM port KPS Status:  Disconnected

Modiication 51
Serialno b
Fiange
15f -
Paiameter Value L
Initial scanring position 0 25l
Final seanning position [
Tire of mictost -> i =
Time of micrast <- 0 3s
Size increment pusion(Diski) [ -
dditional constant - avislBeg) [
Comerichlunale) 0 BUTTE 0 15 20 = a0 @40 & 50 w80 8 70 75 0 85 S0 95 W00 05 0 s 120 125 a0 1 1
Conection factorlKoef1) [ X
Consction factorlKoef2) i
Leg size on 10 microns 0
| Protile Image |
Comp: [Code Value [Code Measured
Paramater L1 2,00 wn | Height (sH) 0,00 i
BRI Paameterl2 (7000 |mm | Thickness(sD) 0.0 mm
Parameter L3 1300 |wm | Gradert o) 000 i
Parsmeter L5 |1500  |mm

Il Messuement Fead param j Calculate

Autocalibr Wite param

[Parametes |

100%

27.1.1. Bluetooth-connection

Select the COM-port and click the Connect button.

CUklpot 44 > | KPS Status: Disconnected
[§ Connect l Device Type
Modification
Serial no
Range

@ For more information, refer to p. 30.

If the connection is successful, the device will be identified, and calibration
parameters will be obtained. The status will be changed to Connected.

COM port 44 S| IEPS Status: Connected
[ @ Disconnect [COM44:] l Devies Type %
I odification 54

Sernial no BOE
Range 55

The table of calibration parameters:

Parameter Yalue
Initial scanning position a0
Final szanning poszition 2860
Time of microzt - B
Tirne of microst <- b
Size increment position[Diskr] 4335
Additional constant X-auiz(xBeq) R330
Corner of turnjalfa) B3
Correction factorF.oef] 0
Correction factor(k.oef2) 0
Leqg zize on 10 microns 0
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Buttons:

la flescuenen ] Measurement

l =\ Read param l

Reading calibration parameters

l ’ Wiike param

Writing calibration parameters

[/ Autocalibr Automatic setting of calibration parameters

@ The Auto calibration button will be active, if at least one measurement of the profile is performed
and the reference profile is selected.

27.1.2.  Calibration of the profilometer

¢ Place the profilometer on the calibration block.

e Select the reference profile from the list (Compare > Reference).
e Perform the measurement (the Measurement button )

¢ Perform the calibration (the Autocalibr button).

e Save calibration parameters (the Write param. buton).

o 5 10 1% 200 25 30 35 40 45 S0 55 60 65 70 75 80 & 90 95 100 105 110 115 120 125 130 135 140
X

|— Meazured profile — Reference profileLoco_33 |

Frofile Image
Compar Code Value ‘ ‘ ‘Cude |Measursd Reference | |
vl Reference r 5 Parameter L1 2,00 mim Height [sH] 2999 30,00 mm
— 2 Farameter L2 7000 |mm | Thickness D) 3132 3192 mm
Parameter L3 12,00 mm Gradient [qf!] 10,33 10,32 mm
Parameter L15 1500 i
=]
| Calculate

Calibration parameters can be set manually. To do it, click left mouse key on the
field of the required parameter value, and enter the new one.

Attention! Writing incorrect values of some parameters can lead to the incorrect work of the
device.

Buttons functions, work with profiles and calculation of required parameters are
described in par. 22.
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27.2. Measurement by using PC

To measure, select Profilometer > Measurement, or click the button a4 )

-

T e L S R
e e e e e .

[ File Settings Register Profilometer Datsbase Tools Window Help [= [=]x]

4 0 o TN @

‘Wheel parameters

Organization : : g : g g : : : g g g g : : : g g g g : : : : g : g :
Measurament date 050116 - o 5 10 15 20 25 30 35 40 45 50 55 60 65 7;: Ts 80 85 90 95 100 105 110 115 120 125 130 135 140
seres
Number 12678 - || Puotie Image |
S —
Comp: Value [code Measured
i L 200 om | He
I ght(sH] 278 |mm
P
Side [ Reference SE02ET 000w Thickness :D] 2851 o
Operator B - 1300 om | Gradent faR) 862 mm
B0 |mm
Miaage —
=]
|7 Calelas
Save
Faramelers
100%

When the Bluetooth-connection is established (see par. 27.1.1), the Measurement
button is active.

27.2.1. Saving of data

¢ Place the profilometer on the wheel
¢ Perform the measurement (the Measurement button)
¢ Enter the identification parameters of the wheelset

YWheel parameters

Organization totive-power depot

tMeasurement date  [0R.01.16 e
Series CM3 -
MHumber 12678 hd
YWheelset
e

Side
Operatar 34456 -
Run

l I & save l

e To save results, click Save

e The measured profile will be saved to the database

Buttons functions, work with profiles and calculation of required parameters are
described in par. 22.
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28. Annex 1. Charging procedure

e Switch off the PDA (laser module)

e Connect the charging device to PDA (laser module)

e Connect the charging device to 220V AC

e Time of charging - 4 hours (full-charge indication: PDA - blue LED is lit; laser
module - green LED is lit)

e Disconnect the charging device from 220V AC

e Disconnect the charging device from PDA (laser module)

@)

Attention! Please follow the sequence of these points.

29. Annex 2. Program for creating the measurement
schemes
To create the measurement schemes, use the special program
SchemeBuilder.exe. When the program is started, the main window appears on the
screen:
rg_"‘i SchemeBuilder 2.0 - new_scheme \ . h |
Axle 1 The rumber of cars 1 Awles in the car 4
Car 1 Current car 1 Bogies in the car 2
‘Wheel parameters et Type of the scheme I
Series 1R o o 4
Car number — — — =
Ll
‘wheelset
Fiun — = l———‘_ =
1L 2L 3L 4L
Save scheme
|
To form the scheme:
¢ Enter the number of cars 2 rLize of eare !
e Enter the number of axles in every car #esinthe car !

o If the measurement of the car is performed in the reverse order, tick the box

Irvert
1

L_I:l Set scheme ]

Type of the scheme

e Select the type of the scheme
e Click the button to accept [
e Next, enter parameters of all wheelsets sequentially for each car

wheel parameters

S Sernes

Car number 1234

Bl 1

Wheelzet
Run

e The fields Axle and Car are used to navigate through the scheme
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Axle 1

Car 1

o Click the Save scheme button| [ ssescheme |
e Enter the name of the scheme in the dialog box window

o ==

Savein: | | SchemeBuilder2.0 j Lol £k B

= Mame Date modified Type
o b
Recent Places

Desktop

=

Libraries

LY

Computer

@

Mo items match your search.

< [0 | r

l File name: |new_schame j Save |
Saveastype:  [SCHfiles ("sch) | Cancel

The program allows to edit the existing scheme. To edit the scheme, click the Load
scheme button and select the *.SCH file. After loading, you can edit and save the wheelset
parameters.

To transfer the scheme file to PDA, use the procedure described in par. 23.1.5.

Clarification. The measurement scheme is a text file with extension .sch. User can
create and edit such file by using any text processor.

Example:
irer 3rdr irer 3rdr 1r2r 3rdr 41 3l 2111 41 3l 2011 41 3l 2011
Car1 Car2 Car3d Car4 Carb Car6 >
12l 314 12 314l 12l 3l 4l 4r3r 2rir 4r3r 2rr 4r3r 2rir

Scheme EXAMPLE

{

1d-ISM 3[7102[11111]SUT1[111[1r{11]SU 11111 |21]12]SU12[112[2r[12]SU12[112]3113|SU 13|113|3r13]SU 13]113[4114]SU14[1144r[14|SU14[114];
2d-|SM 3|7202[11121|SU21[211|1r21|SU21[211]21|22|SU22|212|2r|22|SU22(212|31[23|SU 23[213|3r|23|SU23213]41|124|SU24|214|4r|24|SU24[214];
3d-ISM 3]730211|31]SU31[311|1r31|SU31[311[21[32|SU32|312]2r|32|SU32[312|31|33|SU33|313|3r33|SU33(313]41[34|SU34[314}4r|34|SU34[314];
4i-|SM 3[7402]4r|44|SU044|414141|44|SU44|414|3r/43|SU43]413(31|43|SU43[413|2r|42|SU42(412|21[42|SU42/412|1r/41|SUAT 4111114 1|SU41[411];
5i-|SM 3[7502/4r[54|SU54|514/41|54|SU54[514]3r|53|SU53|513|31153|SU53|513]2r/52SU52|512]21|52|SU52[512|1r{51|SU51(511[11/51|SU51[511];
6i-|SM 3[7602]4r|64|SU064(61441/64|SU64|614|3r/63|SUB3|613|31|63|SU63[613|2r|62|SU62(612|21162/SU62|612|1r61|SU6T|611]11|61|SU61(611];

Where:

1d — coaches arranged in direct order (1 — sequence number)
1i — coached arranged in the reverse order (1 — sequence order)
SM3 - coach series

7102 -number

11 — sequence number of wheel pair and the side (I- left/r-right)
11 — axle number

SU11 — name of wheel set

111 — running distance of wheel set
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30. Annex 3. Testing and calibration

We can supply the profilometer complete with an RF505.11 calibration-wheel
simulation unit (Fig. 1A) and RF505Calibr calibration program that are designed for
periodic testing and self-calibration of the profilometer.

Instead of the calibration unit use can be made of the wheel with known profile
entered to the database (see par. 22.3.6).

Before start the testing and calibration process, it is necessary to set the COM-port
for Bluetooth-connection between the laser scanning module and PDA. The procedure is
described in the user manual that comes with the Bluetooth-adapter.

When you add the device, Windows will ask for the pairing code. The pairing code
for each device consists of 4 symbols and is formed according to a serial number. For
example, if a serial number is 04217, then a code will be 0427; if a serial number is 01318,
then a code will be 0138, etc.

30.1. Preparation for testing/calibration

e Install the RF505 program on the PC
e Install Bluetooth-connection between the scanning module and PC
¢ Place the profilometer on the calibration unit
e Run RF505 program
= RFS05 vLA1 - = [EN

Cobnasbe | L | Disconnected

a
]
TPk Rp hfob « ]
Snap moe 01 moron L]
Asdton cortant on se ke X 0
it of | ARS)

Comacon (oEScenoiTe) 0
Compction conficanties®l] 0
Ly 52w &= 10 Facro

Bl D Ts s a
FHTpawL oatoRT o
Cycls of Talerrg a

¢ To install Bluetooth-connection, select the required port.

COM number Disconnected
§ Connect

The device will be identified, and calibration parameters will be read.
e To perform the measurement, pass to the Profile tab and click Measurement.
After measuring, the display will show the measured profile and the calculated
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geometric parameters of the profile: Height (Sh), Thickness (Sd), Slope (qR).
Parameters are measured at support points L1, L2, L3.

- RESO wIAL2 [ KPS M 86T | - oEN

L= s Conmected ] ——
. 5
(" Daceseact [C0MIS] ¢ A \

B beps £
o vl il | L h
Eivrinir el a s w
M arvszrway varege © (%]

L = a =&
B
o~

Talage LA W - .' 1
ﬁ Tespuarshore : 7438 °C - 1
Cuem T 03 &
Faraatar [ivaisn
T Sl 188
Frral gt M
Tra &> 5
Frah R hirteh «- F

a5 B4 0L maron £ \
Asabonsl corfant oo an ma X 1711 3

Gt of s ) ]
Lot e o e o] ek
Comuction conScantiioe] | *
Ly s 5% 10 el T

H % = & =

S e

¥ F B ¥ B N U
!
1
i
§

|t [

e L
Sagud ol Fuy Scan profily il it | = FeraTeds Habsarid
u 3 mm Heght Sh 27g0
o Rised data by badis
W P [ = i m
| — = - Hastn calwaten
o Caditman

= Pt profie

mm Tk S 12
LE 53 Lo Cradenl gF gy
_’_' Eacatuiate Eamizp ¥ Lo

R e |

e To compare with the reference, tick the Compare box and select the required
reference profile in the Reference drop-down list.

30.2. Testing

To carry out automatic testing, do the following steps:
¢ Tick the N meas. box (nhumber of measurements)
¢ Specify the number of measurements (5-10)

e Click the Measuring button

Compare li1c/ORE -

e) Reference  ( Parameters

(] v el

PEkt

M e

M Profile 1 :

*

-

N meas. 10 -

The scanning module will make the specified number of measurements whose
results will be entered to the table (the Data tab). The first three columns will present
measured values of height (Sh), thickness (Sd), and flange slope (qR), while the other three
columns will present deviations of the measured values from the reference values (d_Sh,
d_Sd,d_gR).
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The Diagram tab is intended for displaying the diagram of values/deviations of the
measured profile from the selected reference. Deviation of the flange height and thickness
from the reference values must not be more than 0.1 mm. f deviations exceed the
permissible value, it is necessary to perform calibration of the scanning module.
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30.3. Calibration

To carry out automatic calibration, do the following steps:
o Select the reference profile from the list

Compare UIC/ORE -
m Measuring

+ Reference 1 Parameters

-

N Profile 1 s o
#, Auto calibration

=
] Recalculate

¢ Perform the measurement (the Measuring button)
e Perform the calibration (the Auto calibration button)
¢ When scanning is complete, perform the testing procedure in accordance with
30.2. In case of positive result, save parameters:
o Right-click on the table and select Write
o Right-click on the table and select Write to FLASH

COM number Connected COM number Connected

&g[}sconnect [COM25:] &g[}mconnec‘c [COoM25:]

Device type : 55 Device type : 55

Serial number : B617 Serial number : B617

Device modification : 85 Device modification : 85

Measuring range : 67 Measuring range : 67

Voltage : 3,768 VW Vaoltage : 3,768 VW
a Temperature : -7,438 °C Temperature : -7,438 °C
Current : 40,203 A Current ¢ 0,203 A

Parameter Parameter |Va|ue
Initial position Initial position
Final position Final position 4670
Time step -> Time step -= &
Time step home <- 2 Time step home <- 2 Write
Step size 0,1 micron 3 Read Step size 0,1 micron 3044 Read
Additional constant on anaxis X |1 - Additional constant on an axis X 1731
Corner of turn(Alfa) 705" Write All parameters Corner of turn(Alfa) 70 £ Write All parameters
Correction coefficient(KoefY) 1( = Read All parameters Correction coefficient(Koefy) 10049 = Read All parameters
Correction coefficient(Koefl - ) i i -
o goTk ( ) 2 o Write to FLASH Corre¢|on coeFﬁc_lent(Koefl) 36 Wr'rle T
eg size on microns <5 Load Default Leg size on 10 microns 9736 %5 Load Default
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30.4. Restoring the factory settings

If parameters have incorrect values (negative or zero), it is necessary to restore the
factory settings by pressing the Load Default button. After that, recalibrate the profilometer.

COM number |25 - | Connected
J&S‘ Disconnect [COM25:]
Device type : 55
Serial number: B617
Device modification : 85
Measuring range : 67
Voltage : 3,768 W
Temperature : -7,438 °C
Current : -0,203 A
Parameter |Va|ue
Initial position 148
Final position 4670
Time step -» 5 Write
Time step home <- 2 Read
Step size 0,1 micron 304 =
Additional constant on an axis X 173~ [t paamei
Corner of turn{Alfa) 70 | = Read All parameters
Correction coefficient(KoefY) 100 g \Write to FLASH
Correction coefficient{Koef1) -36 j Load Default
Leg size on 10 microns 9736 I T S
| / \ | I° O O
f |
N O O

Figure 1A
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31. Annex 4. Software application for working with

the "A.U.R.A. Wheel" system

When working with the A.U.R.A. Wheel system from NEM Solutions, the laser

scanning module is controlled by the special software application installed on a tablet
computer.

31.1. Installation

To install the software, select and run the Ikp5_Tablet.exe file. Follow the guidelines
in dialog boxes of the Installation Wizard. By default, the software will be installed in the
following directory — C:\Program Files (x86)\Riftek, LLC\Ikp5_Tablet\.

To start the program, press Start > All programs > Riftek, LLC > lkp5_Tablet >
Ikp5_Tablet.exe. The main window is shown below:

HTM Laser Wheel Measurement System

_ ™
. Single
] H‘ Settings Measurement

Automated Simple
Measurement Measurement

Ikp5_Tablet 1.5

31.2. Settings

Before starting to work with the profilometer, it is necessary to configure
parameters.

Press the Settings button. The program will require a password. When initially
installed, the program accepts the following password: 1111. How to change the password,
see Par. 31.2.3.

Password:

* Cancel
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Enter the password and press Ok. The window of program settings will appear.

31.21. Language

The user can change the language, form his own language support files as well as
change/edit the terminology used. To select the language, press Language, select the
language support file, and press Select.

« Settings - Language 'L “

Gauge Eng V

Language

2=

—

@ Gauge type
h Password

Parameters

@ Calculation method

f \J./ 7’ Displayed parameters
\i,- 1 L parameters
Tools

Vehicle

Reference

~0 &

Tolerance

-
&

Scheme

B Select

How to create the language support file, see Par. 22.2.4 1.

31.2.2. Gauge type selection

The program allows to work with the following gauges: IKP, IDK, IMR. When
selecting one of them, you will see a list of available devices (i.e. devices that have been
connected earlier).

WY

- 7" .
* Settings - Gauge type 7(,,"
Gauge Gauge type Paired gauges [IKP]
* IKP I
Language _' >
— Railway Whesl Frofiis Gauge |
Gauge type DK
I cuueevr -~
< Whnee! Diameter Measuring Gauge
Password
h (5% IMR
Parameters Back-to-Back Distance Meazuring Gauge
4
\"g {  Calculation method

\f/j‘:’ Displayed parameters
> No Paired gauges
X

L parameters
Tools

u Vehicle
ﬁ Reference
I

Tolerance

-
4

Scheme

@ Add & Select #& Delete

Select the gauge and press the Select button. Parameters of the selected gauge
will be used to connect to it. If the device is not in the list, you can add it — press the Add
button and start to search for Bluetooth devices.
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Tap "Start" to search for other Bluetooth device.

Start \J Pair gauge x Cancel
| | |

Press Start and wait for the search to complete.

Searching for Bluetooth devices...

o

v’.; Pair gauge ‘x Cancel

The detected devices with their serial numbers will appear:

Select a gauge to connect with and tap "Pair gauge"

RF505 04217

| |J Pair gauge
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Select the device and press Pair gauge to include it in the list. Windows will report
an attempt to add a new device, and request a pairing code.

« Settings - Gauge type ‘\.u‘

Gauge Gauge type Paired gauges [IKP]

= L T

L cwomore o s

h Password - IMR
Parameters o ettt e~
]@’-? Calculation method

';;? Displayed parameters

\;\:g | parameters No Paired gauges
Tools

H Vehicle

d Reference

y I Tolerance

v » Scheme

@& Add ® select & Delete

© A Bluetooth device is trying to connect ® X
Click to allow this.

If the pairing code is correct and the device is successfully added, the system will
display a message. The device installation may take some time. The pairing code for each
device consists of 4 symbols and is formed according to a serial number. For example, if a
serial number is 04217, then a code will be 0427; if a serial number is 01317, then a code
will be 0137, etc.

[ = ﬂ v 2
8 I Add a device

S ¥ Add a device

Enter the pairing code for the device This device has been successfully added to this computer
f This will verify that you are connecting to the correct device. Windows is now checking for drivers and will install themn if
3 necessary. You may need to wait for this to finish before your device =
e is ready to use.
0427
The code is either displayed on your device or in the information that To verify if this device finished installing properly, look foritin
came with the device. Devices and Printers.
RF305 04217 W RF505 04217

aring
To help protect your computer from someone accessing it without
your permission, only make your computer discoverable when you
want a Blutooth device to find your computer. Disable discovery
when you no longer need it.

What if I can't find the device pairing code?

Settings - G 2O
ettings - Gauge type LE
Gauge Gauge type Paired gauges [IKP]
F 4,
=B languege =z.= > | e
! Railway Whesl Profile Gauge | S -
@ Gauge type e IDK
< y Whneel Diamete:
Password
h -— IMR
Parameters Back-to-Batk Distance Measuring Gauge
74
(o8 Calculation method
=
\"/f Displayed parameters

(¥ ‘_; L parameters

Tools

H Vehicle
d Reference

I Tolerance

Scheme

@ Add @B select @& Delete
|

Select the device by pressing the Select button.
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RF505 04217

DO126F24A0AT

DK
Whes! Diameter Measuring Gauge
IMR
Back-to-Back Distance Messiring Gauge

Calculation method

Displayed parameters

g L parameters

Tools

A Tolerance
a Scheme

If you do not use the device anymore, you can delete it by pressing the Delete
button. Similarly, you can add other gauges (IDK and IMR).

31.2.3. Password

To change the password, press Password.

Calculation method
Displayed parameters

L parameters

Tools

Ei

o

i

&

n Vehicle

d Reference
A Tolerance
=]

Scheme

Enter a new password, confirm it, and press Save.
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RIFTEK

Sensors & Instruments

31.2.4.

Calculation methods

Press Calculation method. On the screen:

-

Gauge Parameter L3 from: Gradient: Wear:
Language - Rolling circle From L1to L3 - Height
From L1 to L4
Gauge type

@ ge typ Flange . From L8 to L4 _ Equal./Unequal
@

m Password Thickness from: Gradient in: Coordinates center:

Parameters ili
- Inner surf. Millimeters + Flange top
2 Calculation method _ Flange - Degrees o

j"} _ Both values _ Accept./Unaccept. Rolling circle
‘J} Displayed parameters

¥

L parameters

Settings - Calculation method

Units setting:

Invert measurement

"i_

“e i

Averaged measurement(IDK&IMR)

- Millimeters (mm) - No - No
Tools )
H = _Inches (in) Yes JYes
ﬂ Reference
. ! . Tolerance
;_2 Scheme
E] Save
To save the changes, press Save.
31.2.5. Selection of displayed parameters
Press Displayed parameters. On the screen:
.
« Settings - Displayed parameters e -)
m Gauge — 7?;:ramele; - S Shu;H;iii
— sy Height(sH) [ o [
@ RRugaR Thickness(sD) m' |
h Easwor Gradient(qR) m |
P, t
= Parameter(Gap) ﬂl
Calculation method
Wear(Wt) j ¢
Displayed parameters
lope(s! il | o
\{-? L parameters slopee -
Angle(A) il o=
Tools
H vehicle Hollow(HI) L] oFs
ﬂ N Back-to-Back(M) [ on [
’ ! . Tolerance —
;.3 Scheme

In order to select/deselect a parameter, set ON/OFF in the Show/Hide column.

save the changes, press Save.

ﬁ Save

To
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31.2.6. L-parameters

Press L parameters. The table displays only those L-parameters that are
necessary to calculate the selected geometrical parameters of the wheel.

« Settings - L parameters 4 b
Sauas Parameter Value
% Language
L1 2.00 mm
Gauge type
- L2 57.50 mm
| Password
h\ L3 10.00 mm
Parameters
oy L4 17.00 mm
@& Calculation method
9 L8 12.00 mm
Wil Displayed parameters
J", L10 59935 mm
" L parameters
== L11 767.00 mm
Tools
H Vehicle
d Reference
! Tolerance
>
Scheme
H BT
] save

To save the changes, press Save.

31.2.6.1. Preset values

L- Default value Assignment
parameter
L1 2 mm Used for calculation of the flange slope (qR)
L2 70 mm Defines position of the wheel rolling circle, and used for calculation:

- flange height (sH)

- flange thickness (sD)
- flange slope (qR)

- inclination angle (A)
- wheel diameter (D)

- rim thickness (T)

- wear (Wt, Wf, Wr)

L3 13 mm Used for calculation:
- flange thickness (sD)
- flange slope (qR)

- wear (Wf)

L4 13 mm An additional point for calculation of the flange slope (qR)

L5 10 mm Used for calculation of an angular wear (Wr)

L6 70 mm Used for calculation of slope of the rolling surface section (S1)

L7 105 mm Used for calculation of slope of the rolling surface section (S2)

L8 10 mm Used for measurement of the profile inclination angle at the required
point (A)

L9 140 mm Used for inverting the measurement direction (L9 — profile width)

L10 599,35 mm Used for calculation of the profile diameter (D)

L11 767 mm Used for calculation of the reference profile rim thickness (T)

L15 13 mm Used for calculation of the flange thickness of tram wheels (sD15)
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P7_1 50 mm Used for calculation of the hollow (HI)
P7_2 105 mm

P8_1 110 mm

P8_2 130 mm

D1 70 mm Used for calculation of the hollow (HI)
D2 107,5 mm

31.2.7. Reference profile selection and installation

The program allows to compare the scanned profile of the wheel with the reference
profile. To select the reference profile, press Reference.

« Settings - Reference C 3
» ¥4
Gauge Avenio
. language Loco_33
BRU Loco 35 ret
Gauge type GTLS
Cx GTLB.ref
J3 Fossword RegioCitadis
Parameters 9
T 4 . s
{@ | Calculation method
» .
W .\ Displayed parameters 15
y
Lt L parameters #
5
Tools
30 =
u Vehicle 35 i
d Reference = \
45
I Tolerance 0 5 10 15 20 25 30 35 40 45 50 55 60 &5 70 75 B0 85 G0 95 100 105 110 115 120 125 130 135 140 145
[ =1 Scheme
& Import 2 Delete

To delete the reference file, activate the line and press Delete.
To add the reference file, press Import and select the *.ref file.

31.2.7.1. Writing the reference profile to the database

Reference profiles are stored in the database as profile description files with the
ref extension. The software is supplied with several preset profiles.

If there is no required reference profile in the database, the user can request the
missing profile from RIFTEK (free service).

31.2.8. Measurement scheme

The measurement scheme is meant as a sequence of making
measurements/processing of wheels in the rolling stock with specified parameters of each
wheelset (wheelset numbers, car numbers, series, etc.). The program automatically offers
the operator to perform measurement of the wheel in accordance with selected scheme of
wheel processing. The program contains several preset schemes. Besides, the user can
form his own measurement scheme.
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31.2.8.1. Selection or removal of the measurement scheme

To select the measurement scheme file, press Scheme.

« Settings - Scheme ‘LC
Gauge Scheme_A2 N Name of scheme
Language Scheme_A3 Scheme_A4

@ Gauge type Seheme At Number of cars Number of axles Type of scheme

Cx Scheme_ad.sch 1 4 s 1 -

M Password Scheme_A8

Scheme AB.sch
Parameters
7.4
fops Calculation method

I—'}
‘J N Displayed parameters

\\_~£ L parameters

Tools +
u Vehicle 1)
d Reference b
! Tolerance
- 1 3 S 7
.
-‘_‘ cheme

%% Add % Delete S Edit | %o Import
|

Arrows in the figure show the direction of processing of wheelsets as well as the
names assigned to wheels.

To delete the scheme file, activate the line and press Delete. If you delete the
current scheme, the error message will appear.

To add the scheme file, press Import and select the *.sch file.

31.2.8.2. Formation of a new measurement scheme

To form a new measurement scheme, press Add. The following window will appear:

. B
« Settings - Scheme s D:
L
Gauge Scheme A2 Name of scheme
2= i
Language Scheme. A3 NewScheme
: umber of cars er of axles Typ eme
@ Gauge type e Al Number of cars Number of axle ype of schem
Cx Seheme Adsch 1 & s 2 -
M Password Scheme A8
Parameters
7.4
e:;' Calculation method
-
‘JJ‘{ Displayed parameters

12

A 6 8 10
2 2
Ll Lparameters
Tools >
u Vehicle 10
d Reference <
! Tolerance
- 3 5 7 9

-‘_‘ Scheme
«'f? Ok * Cancel

Next:

¢ enter the scheme name;

e select the number of cars;

e select the number of axles;

e select the wheel processing scheme out of the options suggested;
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e press OKk.

This method of the measurement scheme formation allows to create only simple
schemes without specifying the wheelset numbers, car numbers, series, etc. To form a
complete scheme, see par. 29.

31.2.9. Tolerances

The program automatically controls measured geometric parameters for going out
beyond the tolerances set. Itis possible for the user to create groups of tolerances. Control
of parameters will be performed for a selected group.

To select a current group of tolerances, press Tolerance. The table will show
tolerances only for the selected geometric parameters of the wheel.

A red color indicates the maximum/minimum critical values of parameters. An
orange color indicates the maximum/minimum values, which are close to critical values.

# Settings - Tolerance 2O
G Name of tolerance .
augs - - Parameter - War.Min War.Max -
= Language RegicCitadis
Height(sH) 23.00 27.00 32.00 33.00 mm
@ Gauge type GTL8
i Thickness{sD) 20.00 22.00 32.00 34.00 mm
M Password Avenio
L Gradient(gR) 2.00 4.00 11.00 12.00
Parameters
-—»’ Parameter(Gap) 0.00 0.00 0.00 0.00 mm
\é- {  Calculation method
‘)’—\. Diameter(D) 0.00 0.00 0.00 0.00 mm
\% - Displayed parameters
e 3 Back-to-Back({M) 0.00 0.00 0.00 0.00 mm
W  Lparameters
Tools
u Vehicle
ﬁ Reference
! Tolerance
"‘ : Scheme

Y% Add & Delete Ay Edit

To delete the tolerance, activate the line and press Delete.
To edit the tolerance, activate the line and press Edit.
To add a new tolerance, activate the line and press Add. On the screen:

« Settings - Tolerance X ¥
by
Name of tolerance
Souge el il Parameter - War.Min War.Max -

gi= Language New tolerance
= Height(sH) 0.00 0.00 0.00 0.00 mm
(@ Gauge type RegioCitadis

ke Thickness(sD) 0.00 0.00 0.00 0.00 mm

Password GTL8
L4 Gradient(gR) 0.00 0.00 0.00 0.00
Parameters Avenia

—'—" Parameter(Gap) 0.00 0.00 0.00 0.00 mm
@ Calculation method i Ik 1
Jf? Diameter(D) 0.00 0.00 0.00 0.00 mm
\/- -4 Displayed parameters

e J Back-to-Back(M) 0.00 0.00 0.00 0.00 mm
(Al Lparameters

Tools

H Vehicle
ﬂ Reference

! Tolerance
"' 6. Scheme

«'i Ok w Cancel
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Enter the tolerance name into the Name of tolerance field and the values into the
Min/War.Min/War.Max/Max fields. To save the changes, press Save.

31.2.10. Vehicles

To view a list of rolling stocks, press Vehicle. The listed rolling stocks can be
selected for measurement.
Parameters of the rolling stocks:

Vehicle name Name of the rolling stock
Vehicle Id Identification number of the rolling stock
Vehicle description Description of the rolling stock
Schedule Schedule for the rolling stock
Send to AURA Sel?ct "Yes" if you want to send data to the AURA database, or select "No" if you
don't
Scheme Measurement scheme name
# axles Number of axles
# wheels Number of wheels
Reference Reference name from a list of references (Reference tab)
Tolerance Tolerance name from a list of tolerances (Tolerance tab)
« Settings - Vehicle r'
Gauge Vehicle name Vehicle IC Scheme

E’.ﬁ. . ] 1870846 Scheme_A8 3

@ Gauge tyie 3001 m) etk deseintin # axles # wheels

3;% —_— 3002 GTL8 8 16

s Parameters 3003 Reference
J\;' Calculation method 3004 GTL8
!.’; Y Displayed parameters 3005 Schedule Tolerance
\G’_’ L parameters 3006 lis e
Tools 3007 send to AURA
H Vehicle 3008 No
R reference 2008
I Tolerance

W Add M Delete ¥ Edit

To delete the rolling stock, activate the line and press Delete.
To edit the rolling stock, activate the line and press Edit.
To add a new rolling stock, activate the line and press Add.

31.3. Measurements

There are three types of measurements:

1. Single Measurement — measurement without specifying the rolling stock type,
measurement scheme, tolerances. Measurement results can be saved to the
WMC format.

2. Simple Measurement — measurement of the selected rolling stock with
specifying the scheme and tolerances. Measurement results are saved to the
WMC format.
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3. Automated Measurement — measurement of the selected rolling stock with
specifying the scheme and tolerances. Measurement results are transferred to
the AURA database.

31.3.1. Single measurement

To enter the mode, press the Single Measurement button.

—
« Single Measurement =
- H : 0.00 mm
¢
sD : 0.00 mm
Measurement
) qR : 0.00 °
L] .
- :
5
10
13
20
23
Pl |
5 =n
. =
4SD 5 10 15 20 25 30 35 40 43 30 53 60 G5 TO 75 80 83 %0 95 100 105 110 115 120 125 130 135140 145 Sav? tc WMC
A —— — —

First, you need to establish the Bluetooth connection to the gauge: IKP, IDK or IMR.
Gauge

select the gauge -

.=-' RF505 00000 @

Disconnacted

H IDK 01612 @

Disconnected

The list contains devices selected in settings (see Par. 31.2.2. "Gauge type
selection"). After selecting, press the Connect button.

Gauge

RF505 03017 @ -

| Disconnected

Connect

The Measurement button and the charging indicators will be active.

¢ Press the Measurement button.

o After pressing the Measurement button, the laser module starts scanning of the
wheel surface. During the scanning process (1-2 seconds), a red LED is lit.

e When the scanning process is complete, the program displays the measurement
results.
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[ Single Measurement @
| ~ Gauge ;__ 7 :
= SH 2933 mm | emp |
| -l' RFS0S 04217 )
| |
| Cisonicct | S D : 3 2 . 7 6 mm Measurement

L b ——

gR : 67.19 °

H Tablet 69% : \\\ @

45
3 RFS505 60% © 5 10 15 20 25 30 35 40 45 50 53 60 G5 70 75 60 85 S0 95 100 105 110 135120 125 130 135140 145 | | Save to WMC

|
|
|
15 |
|
|
|
|
|

Measurement results and profile coordinates can be saved to the file of the WMC
format. The files are saved to the following directory:
C:\Riftek,LLC\Ikp5_Tablet\Measurements\Losse metingen\

Measurements saved in WMC format!
Path: C:\Riftek, LLC\Ikp5_Tablet\Measurements\Losse
metingen\\

o Ok

The IDK is designed to measure the wheel diameter. The IMR is designed to
measure the back-to-back distance. In order to change the gauge type, press the
Disconnect button, select the gauge you need, and press Connect.

The measurement procedure is similar to IKP.

31.3.2. Simple measurement

To enter the mode, press the Simple Measurement button. This mode allows to
perform measurements in accordance with the roling stock parameters (scheme,
tolerances, reference).

First, you need to select the rolling stock in the Select Vehicle window. The list
contains only those rolling stocks, the measurement results of which will not be sent to the
AURA database (the Send to AURA column is empty).
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i‘ « Select Vehicle H ‘

‘ »
| Vehicle name Vehicle description Schedule # axles # wheels Send to AURA
{ Aanhangwagen, 4-assig, 1929
| HM769 (HOVM) HM 4 assen o 8
HM77 Motorwagen, 2-assig, 1905/1930 (TS) HM 2 assen 2 4
HM779 Aanhangwagen, 4-assig, 1926 (TS) HM 4 assen 4 8
|
Aanhangwagen, 4-assig, 1929
H HM780 (HOVM) HM 4 assen 4 8
HM810 Motorwagen, 2-assig, 1927 (HOVM) HM 2 assen 2 4
| HMB819 Motorwagen, 2-assig, 1927 (HOVM)  HM 2 assen 2 4
|
| HM826 Motorwagen, 2-assig, 1929 (HOVM)  HM 2 assen 2 4
Aanhangwagen, 2-assig, 1927
| HMS305 (HOVM) HM 2 assen 2 4 '
HM946 Aanhangwagen, 2-assig, 1930 (TS) HM 2 assen 2 4

IJ ok

Select the rolling stock (or specify its name in the search line) and press OK.
The program will show the measurement scheme and parameters for the selected
rolling stock.

« Simple Measurement @ |

Gauge Wheelset parameter Calculated parameters

- " Date : 8/30/2017 sH 0.00 mm .
i I; | Vehicle name : HM780 D 000 mm
Send 0 AURA  : Mo el e
Reference : Loco 33 D 000 mm
Tolerance : Tolerance M 000 mm (VieasUIEIm et
Scheme : Scheme_A4
Bogie z '
Schedule : HM 4 assen
Vehicle description : Aanhangwagen, 4-assig, 1929 @'
(HOVM)

Save to WMC

I | 1m| I = =)
1 3 5 7 % *

Next, select and connect the gauge: IKP, IDK or IMR. The connection procedure is
described in the previous paragraph.

When the connection is established, the Measurement button will be active and
you can start measurements.
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1
T
« Simple Measurement  wic | |
|
Gauge Wheelset parameter Calculated parameters
-—' RF505 04217 O A Date s 8/29/2017 sH : 0.0 i
fatneced Vehicle name : HM780 sD 0.0 mm
R : 0.00 *
Send to AURA : No 3 % .
Setiies Reference : Loco_33 M : 000 mm
Tolerance : Tolerance Measurement
Scheme : Scheme_A4
Bogie i -
Schedule : HM 4 assen n
a Tablet 69% i (v |
Vehicle description : Aanhangwagen, 4-assig, 1929 =
(HOVM)
RF505 60% Save to WMC

I II ! - =
1 3 5 7 @jl*

Designations and buttons:

1
{6) an ordinal number of the car to be measured (number of cars in the rolling stock)

=P pass to the previous/next wheel

[ e}
&= = pass to the previous/next car

a measured wheel

a wheel to be measured the next time

a non-measured wheel

parameters of the measured wheel are beyond the tolerances

parameters of the measured wheel are close to the tolerances

A[HN

measurement

Measurement

31.3.2.1. Measurement

e Press the Measurement button in order to measure the wheel offered by the
program (highlighted in green). The laser module will scan the wheel surface.

e Upon completion of the scanning process, the program will show the values of
selected geometrical parameters.
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[‘ - sl paraisices : @‘
sH 2991 30.00 mm -=1

| sD 31.90 31.92 mm ‘—m
gR : 10.32 10.32 mm tow oy

o (2 Aeply
5 10 15 20 25 30 35 A0 45 50 55 60 G5 70 75 80 85 80 85 b1 105 110 115 120 125 130

When the value is beyond the tolerances, it will be highlighted in red:

l\‘ « ‘ Wheel parameters : @ ‘
sH : 32 30.00 mm .-=-1
S D : _ 3 1'92 m m ‘ Measurement ‘
s L
gR : 10.73 10.32 mm stow oy,
:o | E] Apply
T T T D e e e e 7 e E e e T |

The program allows to display only parameters of the measured profile. To hide the
reference values, you need to disable the Show Reference option (select "Off").
¢ To repeat the measurement, press the Measurement button.
¢ When a satisfactory result is obtained, press the Save button to save it.
e The program will offer to pass to the measurement of the next wheel in
accordance with the selected scheme of measurement.
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i , =
Simple Measurement v |
| o |
Gauge Wheelset parameter Calculated parameters
=g FF0s 07 G - 25 : 8/30/2017 sH @ 000 mm
Earntied Vehicle name : HM780 sD 000 mm
R : 0.00
Sendto AURA  : Mo 9% & L
Disconnect D 0.0¢ mm
- Reference : Loco 33 M 000  mm
Tolerance : RegioCitadis Measurement
Scheme : Scheme A4 - -
Bogie 2 -
Schedule : HM 4 assen I
j Tablet 57% i [wwec |
Vehicle description : Aanhangwagen, 4-assig, 1929 :
(HOVM)
RF505 59% Save to WMC

l |1‘1:I I = =)
1 3 5 7 *E%

e To view the results of previous measurements, you can use the arrows. If you
select the measured wheel, the program will display the saved wheel parameters.

i : =
« Simple Measurement wic |
| : |
Gauge Wheelset parameter Calculated parameters
-1 RFS05 04217 0 5 Date s 8/30/2017
Connested Vehicle name = HM780
Send to AURA : No
DEComuec Reference : Loco 33
Tolerance : RegioCitadis Measurement
Scheme : Scheme_A4d - -
Bogie 3 '
Schedule : HM 4 assen |
a Tablet 57% i ; 3
Vehicle description : Aanhangwagen, 4-assig, 1929 c
(HOVM)
RF505 59% Save to WMC

I | wI I - =)
1 3 5 7 * E%

¢ When you measure the wheel that was already measured, the program prompts
you to replace the existing values with the new ones.
The measurement results can be saved in the WMC fromat. Each measurement is
saved in a separate file. The path:
C:\Riftek LLC\Ikp5_Tablet\Measurements\WMC\HM780_20170830\
Where HM780_20170830 is the directory name, HM780 is the rolling stock name,
20170830 is the date of measurement (yyyymmdd).
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Measurements saved in WMC format!

Number of saved files: 8

Path: C:\Riftek, LLC\Ikp5_Tablet\Measurements\WMC
\HM780 20170830\

IJ ok

31.3.2.2. Measuring by IDK, IMR

To measure the wheel diameter and back-to-back distance, disconnect from IKP by
pressing the Disconnect button, and select the gauge you need: IDK (to measure the
wheel diameter), or IMR (to measure the back-to-back distance).

L « Simple Measurement @
~Gauge ~ Wheelset p ~ Calculated parameters
- oxoi612 @ .| O : 8/30/2017 D : 000 mm ﬁ.
- Comected | Vehicle name t HM780
Send to AURA : No
Ricatict Reference : loco_33
Tolerance : RegioCitadis (MEsUiEmEnt
Scheme : Scheme_A4
Bogie : Lo
Schedule : HM 4 assen =
T s v g
Vehicle description ; Aanhangwagen, 4-assig, 1929
(HOVM)
Save to WMC

l | m) l l ‘-\ -'.
1 3 5 7 *\ *,

The measurement process is similar to IKP.
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¥

« Wheel parameters

Measurement

D : 971.47 B

mm

Set Zero

(=1 Apply

The measurement results can be saved in the WMC format. Each measurement is
saved in a separate file.

31.3.3. Automated measurement

The Automated Measurement mode as well as the Simple Measurement mode
allows to perform measurements in accordance with the rolling stock parameters (scheme,
tolerances, reference).

The only difference is that the list contains only those rolling stocks, the
measurement results of which will be imported to the AURA database (the Send to AURA
column is ticked).

Attention! The Internet connection is required in order to connect to the AURA database and to
transmit data.

« Select Vehicle H

p

Vehicle name Vehicle description Schedule # axles # wheels Send to AURA i
4001 Regio Citadis RHL 8 1 v

4002 Regio Citadis geaml 8 1¢ v

4003 Regio Citadis B 16 v

4004 Regio Citadis 8 6 v

2005 Regio Citadis 8 1€ v

4006 Regio Citadis 8 16 v

4007 Regio Citadis 8 16 v

4008 Regio Citadis 8 1 v

4009 Regio Citadis 8 16 v

ok

The measurement procedure has one difference from the Simple Measurement
mode. In order to import data to the AURA database, it is necessary to measure all cars of
the selected rolling stock according to the measurement scheme. Only in this case the
Send to AURA button will be active.
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| « Automated Measurement w ‘

Gauge Wheelset parameter Calculated parameters

—' RFS0504217 @ - Date : 8/30/2017 sH - 2991 mm -
Connected Vehicle name : 4002 sD : 31.88  mm
R : 10.23
sendto AURA 1 Ves g nm
Disconnect D 0.0 mm
o Reference : Loco_33 M : 0.00 mm
Tolerance : RegioCitadis Measurement
Scheme : Scheme_ A8 _— — .
Bogie

Schedule : Regio Citadis
Tablet 36% w

Vehicle description : Regio Citadis

j RF505 58% Send to AURA
2 4 6 8 10 12 14 16
I I I I]“I I “ %
1}
1 3 5 7 9 11 13 15 |

After pressing the Send to AURA button, the data transmission window appears. In
case of successful identification in the AURA system, the data transmission starts.

1 oy

Transferring... AURA

* Terminate

When the data is successfully transferred, the following message appears:

J Close
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If any error occurs while connecting to the AURA system (for example, if there is no

Internet connection), the error message appears.

REST request failed: Execution of request
terminated with unknown error!

J Close

In this case, you need to check the Internet connection and try to transmit data again

by pressing the Try Again button.

To avoid the data loss, all measurement results are also copied to the directory:

C:\Riftek LLC\Ikp5S_Tablet\Measurements\ AURA\4002_ 20170830\

Where 4002_20170830 is the directory name, 4002 is the rolling stock name,
20170830 is the date of measurement (yyyymmdd).

32. Warranty policy

Warranty assurance for the Laser Profilometer — 24 months from the date of putting

in operation; warranty shelf-life — 12 months.

33. List of changes

Date Revision Description
17.05.2017 |1.0.0 Starting document.
10.11.2017 |1.1.0 Added section 31 'Software application for working with the A.U.R.A. Wheel
system'.
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